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I. Introduction
Mozilla Firefox, or simply Firefox for short, is just a free Internet browser. It's not a cure for cancer. It 
doesn't wash your car or make you a frothy coffee. So why all the fuss and hype over Firefox? In a 
nutshell, the reason is simple: Firefox is a true open source competitor to Microsoft's Internet Explorer.

"What's wrong with Internet Explorer?" you say - well despite being a good browser, Microsoft was 
getting complacent. Internet Explorer's vulnerability to numerous security breaches was growing by the 
day, yet many simple things MS could do to patch these up were left undone. Internet Explorer lacked 
many convenience features often-requested but never delivered. And finally, Internet Explorer did not 
adhere to completely to web standards; it pretty much set its own standards. In short Internet Explorer 
lacked competition. However all that has changed since Firefox became a legitimate challenger. 
Firefox has forced Microsoft to incorporate many much-needed security, convenience and 
customization features into the latest version of the world's most used Internet browser, Internet 
Explorer 7. All of this has been spurred on solely by Firefox's existence and growing popularity, so 
even if you're a dyed-in-the-wool Internet Explorer user, you have Firefox to thank for these 
improvements.

Ok, so aside from helping improve Internet Explorer, what else makes Firefox great? That's easy to 
answer: It has all the useful and familiar features of Internet Explorer, yet provides additional features, 
tight security, correct adherence to web standards, much less of Internet Explorer's quirky behavior, 
and most important of all: far greater potential for customization. In recently releasing Firefox 2.0, the 
Mozilla Foundation has further improved Firefox, adding useful new features and tightening its code 
base to prevent new security vulnerabilities. Now more than ever, Firefox stands as a true competitor to 
Internet Explorer.

Whether you're a first-time user or a veteran, this Firefox Tweak Guide brings together all the major 
tips, tricks and tweaks for Firefox. From the basic to the advanced, the following 11 pages of 
information are sure to enhance your Firefox experience. Most of all you can rest assured that the guide 
is not written by a raving Firefox fanboy - it's a true objective TweakGuides tweak guide, and not a 
gushing ad for a free web browser. Go ahead and try it for yourself.

Note: This guide refers to the latest official version of Mozilla Firefox Version 2.0. The guide is  
designed specifically for those running Firefox on Windows XP, however most of the tweaks in this  
guide apply to Firefox on other platforms. Make sure to check back regularly for updates.

mailto:persianimmortal@tweakguides.com
http://www.microsoft.com/windows/ie/
http://www.microsoft.com/windows/ie/


2. Essential Optimization
Before getting into any more Firefox tweaks or tips, this section covers the obligatory system 
optimization information I include in all my guides. If you've followed this advice recently, you can 
skip this section.

Basically aside from tweaking Firefox itself, you will need to make sure that your entire system is 
optimized, virus free and stable. Simply doing some general system optimization alone can get you a 
very noticeable performance boost in all your games and applications, not just Firefox.

The place to start is my: TweakGuides Tweaking Companion. The totally revised TweakGuides 
Tweaking Companion is the complete system optimization guide for Windows XP users. It contains an 
enormous amount of detailed descriptions and resources together in one free 175 page downloadable 
PDF file. Everything from the correct installation of Windows and critical software and drivers, 
through to recommendations for every significant setting in XP, all the major performance, visual and 
convenience tweaks, and descriptions of XP's functionality. The guide contains dozens of links to 
major free applications for optimizing and maintaining your system, as well as to a vast range of 
resources for finding out more about your PC and troubleshooting PC problems. Basically the 
TweakGuides Tweaking Companion is the mother of all Windows XP tweak guides and system 
optimization guides.

Also note that the TweakGuides Tweaking Companion has an entire chapter dedicated to optimizing, 
customizing and troubleshooting/repairing Internet Explorer. So for those times you have to use IE, or 
if you run it alongside Firefox, it is a must that you read the guide to optimize Internet Explorer as well 
as Firefox.

If you've ever wondered what common graphics and display settings like FPS, VSync, Refresh Rate, 
Antialiasing and Anisotropic Filtering are, and how they really work, then check out my Gamer's 
Graphics & Display Settings Guide for all the details in an easy to understand format. The guide also 
gives you a rundown on exactly how a game goes from a being a set of files on your hard drive to a 3D 
image on your screen, including relevant performance tips.

Finally, if you run an ATI or Nvidia graphics card, I have written two comprehensive guides which you 
should check out: the ATI Catalyst Tweak Guide and the Nvidia Forceware Tweak Guide. These 
guides cover absolutely everything about the latest graphics drivers, how to set them up correctly, as 
well as advanced tweaking, overclocking and benchmarking tips. They're a must-read for configuring 
your graphics card correctly.

The above information really will serve you well in the long run. If you don't optimize your system and 
keep everything updated and maintained correctly you will keep running into "mysterious" problems 
time and time again. Do yourself a favor and when you get a chance spend an afternoon or two 
optimizing your machine the right way with the guides above. That way Firefox, and all your games 
and applications will perform at their best.

The next section covers the basics of Firefox.

3. The Basics

What is Firefox?
It may seem odd to have this question here, but I want to be absolutely certain that every new user 
reading this guide is aware of precisely what Firefox is, what it does, and how it is different from other 
products released under the Mozilla banner. You may have seen a lot of hype about Firefox, so let's 
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sort out the facts first up.

Mozilla Firefox - simply called 'Firefox' for short - is basically just a free Internet browser, the same as 
Internet Explorer for example. Mozilla on the other hand refers to a separate suite of web-related 
applications which includes the browser, along with a mail client, a chat client and more. So why is 
Firefox so popular instead of the whole Mozilla Suite? Primarily because it is a small convenient 
package, and because it means that you don't have to suddenly switch from all your favorite 
applications such as Outlook Express, mIRC, etc. to use it. You can download and use Firefox 
alongside all your other web-based applications - even Internet Explorer - without any problems 
whatsoever. It doesn't take over your system or install dozens of useless add-ons or extra programs 
which clutter your PC. If you choose to uninstall Firefox, it doesn't leave a mess behind either; it is 
totally safe to use.

"Ok" you say, "I'm lazy...why should I bother downloading, installing and tweaking Firefox - why can't 
I just keep using Internet Explorer?" Well firstly there's no reason why you can't use both browsers at 
the same time. This guide is not here to convince you that Microsoft is the Great Satan. Internet 
Explorer 7 is a fine browser in its own right, and Firefox and IE work perfectly fine alongside each 
other. However the best reason to start using Firefox is that aside from providing you with top-notch 
security, Firefox has a range of features which are not available in Internet Explorer. Firefox can be 
customized in many, many more ways than Internet Explorer can. Firefox is constantly evolving and 
because it is open source software, it has a thriving community of developers who invest a lot of time 
and effort in quickly responding to user needs, fixing up any vulnerabilities to exploits ASAP, and 
generally making Firefox the browser to beat. In fact the developers go out of their way to request that 
users provide them with ideas for new features for upcoming versions of Firefox.

At the end of the day I recommend you do yourself a favor, step out of your comfort zone for a 
moment, and put in maybe 20 minutes to download, install and play around with Firefox. If you're still 
not interested, then that's fine. I have a detailed chapter on tweaking Internet Explorer in my free 
TweakGuides Tweaking Companion which you can download and use instead.

The History of Firefox
To understand how Firefox came about, and how its feature set has developed, you might want to read 
about Firefox's interesting history. For a detailed and accurate look at the history of Firefox read this 
Wikipedia Article. The article also provides a listing of all the various Firefox versions past, present 
and future, and the major changes they involve. For a more general look at Firefox and its features, 
read this Wikipedia Article.

Firefox 2.0
With the recent release of Firefox 2.0, Firefox has further gained a range of optimizations under the 
hood to run even better than before. These optimizations and new features are detailed here, as well as 
throughout this guide. For the most part, the most noticeable new features include:

• A visual refresh of Firefox's default theme. 
• Built-in phishing protection to provide enhanced security. 
• Built-in spell checker, including the ability to add and customize dictionaries. 
• Enhanced search functionality. 
• Improved tabbed browsing, including better organisation of tabs and tab close buttons. 
• Session Restore feature allows you to resume browsing from where you left off last time. 
• Improved Add-ons Manager for managing Extensions and Themes.

Basically while much has remained the same, and the visible changes are not dramatic, Firefox is 
improved and more secure, more functional then ever. If you're running any older versions of Firefox it 
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is strongly recommended you download and install Firefox 2.0 as soon as possible.

Downloading and Installing Firefox
The Firefox browser is a completely free download, and quite a small package at around 5MB. The 
system requirements for Firefox are listed here, but basically the browser can be installed on virtually 
every computer using a recent version of Windows, Linux, or Mac OS X. To download Firefox, click 
the button below:

Note: I don't receive any income or benefit from referring you to Firefox throughout this guide. I am 
not affiliated in any way with the Mozilla Foundation.
If you are a non-English International user, to download the correct version for your operating system 
and language, go here and click on the relevant link. This is recommended in particular for features like 
the spell checker which are region-specific.

If you're running an earlier version of Firefox, you can check the Firefox Release Notes for major 
differences in each version of Firefox under various platforms up to and including the current version.

Once you've downloaded the installation package, installing Firefox is simple - just run the package. If 
you've downloaded a build of Firefox which comes as a .zip archive and has no installer, simply create 
a new Firefox folder under your \Program Files directory and extract its contents there. You can then 
start Firefox by running the Firefox.exe file.

If you're a first-time user of Firefox you can skip to the Setting Up Firefox section further below. If you 
have a previous version of Firefox currently installed on your system, read the Uninstalling Firefox 
section below first.

Note that during the initial installation of Firefox, you will be asked whether you want to import your 
current bookmarks, saved passwords, browsing history etc. from Internet Explorer. I recommend that 
you select Yes to this option, as it will make the transition to using Firefox much easier. However if 
you say No at this point, you can still choose to import any of your IE settings later on, so it is not 
critical that you do so now.

Uninstalling Firefox
If you have a previous version of Firefox before Version 2.0, I strongly suggest that you uninstall it and 
then install the full 2.0 package or newer. This will prevent a wide range of problems down the track. 
Once Firefox 2.0 is installed, you can then use the automatic update feature to keep it up to date 
quickly and easily. Uninstalling Firefox doesn't remove your bookmarks or settings/tweaks by default. 
However uninstalling and cleaning out all the Firefox files including your profile(s) is also an excellent 
way of resolving any extremely strange behavior or annoying problems you may get with Firefox. In 
any case, if you want to completely remove all traces of Firefox from your system follow these steps:

1. Go to Windows Control Panel>Add/Remove Programs, and if a 'Mozilla Firefox' entry (or similar) 
exists, select it and click Change/Remove and uninstall it. You can also uninstall Firefox by going to 
the \Program Files\Mozilla Firefox\uninstall\ directory and running the Uninst.exe file. Reboot as 
required.

2. Go to your Documents and Settings\[username]\Application Data\Mozilla directory and delete the 
entire \Firefox subdirectory and all of its contents. Note that this will delete all of your bookmarks and 
saved settings, so if you want to backup any or all of your current Profile, see the Customizing Firefox 
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section on page 7 of this guide first. Typically all that I would recommend you backup and restore is 
your bookmarks.html file.

3. Go to your \Program Files\Mozilla Firefox\ directory and delete it and all of its contents.

4. Using a registry cleaner like RegCleaner 4.3, find and remove all Firefox/Mozilla-related entries 
(usually there are several Mozilla entries to be found) and remove them. Alternatively you can use the 
Registry Editor (Start>Run>Regedit) and delete the following keys - that is, right click on their name in 
the left pane of Registry Editor and select Delete:

[HKEY_CLASSES_ROOT\FirefoxHTML]

[HKEY_CURRENT_USER\Software\Classes\Applications\firefox.exe]

[HKEY_CURRENT_USER\Software\Mozilla]

[HKEY_CURRENT_USER\Software\MozillaPlugins]

[HKEY_LOCAL_MACHINE\SOFTWARE\Mozilla]

[HKEY_LOCAL_MACHINE\SOFTWARE\mozilla.org]

[HKEY_LOCAL_MACHINE\SOFTWARE\MozillaPlugins]

That will remove the bulk of the Firefox-related settings which can cause problems with newer 
installations if they have become corrupted (through overclocking for example). Note: If you also have 
Mozilla Thunderbird or any other Mozilla products installed, make sure to only uninstall entries under 
the keys above which relate directly to Firefox.

In most cases you should only have to undertake Step 1 of the above list. However again I must stress 
that if you are having any problems with Firefox and nothing else in this guide works to resolve it, then 
I suggest you follow all the steps above. Once again if you need to backup any of your bookmarks or 
settings first, read the Customizing Firefox section before following the steps above; fully uninstalling 
Firefox as detailed in steps 1 - 4 above deletes all your customizations, settings and history.

Setting Up Firefox
Since Internet Explorer is still the most popular Internet browser in the world, Firefox is designed to 
quickly and automatically adopt your existing Internet Explorer settings. You may have already 
imported a range of settings from Internet Explorer as part of the Firefox installation process. However 
if you haven't yet done this, or if you want to update these again, go to the File menu in Firefox and 
select the Import item. Select the browser you want to import settings from, and click Next. On the next 
screen select the components you wish to import and follow the prompts after that.

Using Firefox for the First Time
If you're not familiar with Firefox, that's not a problem. Firefox is almost identical to Internet Explorer 
in its core functionality and interface, so using it is fairly intuitive. Virtually everything works the way 
you would expect it to. The most noticeable differences are: a slightly different - and highly 
customizable - appearance; 'Tabbed Browsing' which allows you to open links as tabbed sub-windows 
in the main Firefox window instead of opening up a new instance of Firefox; the lack of a 'click' sound 
when you click on hyperlinks; and the ability to use Add Ons such as extensions and themes to add 
advanced functionality to Firefox. Of course Firefox has a lot more features and benefits than just 
these, but these are the more obvious things you may notice at first over Internet Explorer 6 or 7.

One of the major advantages of Firefox is the fact that its appearance and functionality can be altered to 
suit your tastes in many more ways than Internet Explorer ever could. Once you have a handle on the 
basic settings, you can try the Advanced Tweaks section to really customize and optimize Firefox.
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On the next page we start looking at how to correctly configure Firefox's in-browser options - this is 
very important and should not be skipped.

4. Firefox Settings

This section covers all the main Firefox settings which can be accessed under the Firefox options 
menus. Before you do any customization or tweaking of Firefox, you need to understand what all of 
these settings do, and make sure that they are configured correctly for your machine.

The main Firefox settings can be found by going to the Tools menu and selecting Options. Each section 
of the Options window is covered in detail below, with my recommendations where relevant:

 

Main
When Firefox starts: Whenever you launch Firefox, you can configure it to do one of the following: 
'Show my home page' will load up the home page you set in the Home Page option (see below); 'Show 
a blank page' will simply start Firefox with a blank page; and the 'Show my windows and tabs from last 
time' option' will use Firefox 2.0's new Session Restore feature to restore all your open browser 
windows/tabs to exactly the way they were when you last closed Firefox. Select the option you prefer, 
but obviously the more pages Firefox has to load when starting up, the slower startup may be.

Home Page: If you've chosen the 'Show my home page' option under the When Firefox Starts setting 
(see above), you can set the home page which appears whenever you open up Firefox. You can either 
manually enter a web address in the Locations box; if you want to set the page you are currently 
viewing as the home page click the 'Use Current Page' button; or you can choose a page from your 
Bookmarks. You can set multiple homepages as well, each opening up in a separate tab when you 
launch Firefox or click the Home button - see the Customizing Firefox section.

Downloads: When Firefox begins downloading a file using its built-in download manager, and the 
'Show the Downloads window when downloading a file' box is ticked, you will see the Download 
Manager window appear. This is useful as it shows you the progress of the file download, and gives 
you the option of cancelling the download at any time - hence I recommend you tick this option. I 
suggest you also tick the 'Close it when all downloads are finished' box so that when all downloads are 
completed the download manager box automatically disappears as well.
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Save Files To: Every time you choose to download a file from the Internet with Firefox, the download 
manager will save it to a particular location. You can either select to have Firefox 'Ask me where to 
save files' for each file, or as I recommend, select a fixed download folder under the 'Save all files to 
this folder' box. Note: I don't recommend saving files to Desktop, as this can increase Memory usage in 
Windows.

System Defaults: Whenever you click on a hyperlink in an email, document or PDF file Windows uses 
your 'default browser' to view the web page. On Windows this is always Internet Explorer unless 
otherwise specified. The 'Always check to see if Firefox is the default browser on startup' option if 
ticked allows Firefox to check whether it is the default browser each time it starts, and set itself as such 
if it is not. You should untick this option by default for fastest startup, and instead if you want Firefox 
to be the default browser, go to your Windows Control Panel>Add/Remove Programs. On the left hand 
side of the 'Add or Remove Programs' box, click the 'Set Program Access and Defaults' icon. Select the 
Custom option, and under the 'Choose a default web browser' section select 'Mozilla Firefox'. However 
make sure you also tick the 'Enable access to this program' box next to Internet Explorer - you need to 
use Internet Explorer to run the Windows Update feature for example, not to mention that some other 
pages may not open and/or view correctly with Firefox. Click OK to close, and now Firefox is your 
default browser. To confirm this, click the 'Check Now' button.

Next, go into Internet Explorer, and under the Tools menu select 'Internet Options'. Under the Programs 
tab, at the very bottom of the box untick the 'Internet Explorer should check...' or 'Tell me if Internet 
Explorer is not...' box so that Internet Explorer doesn't nag about this or switch itself back to being the 
default browser each time you run it.

Tabs
New pages should be opened in: This setting essentially controls whether you use tabbed browsing or 
not. It comes into effect any time you launch a new web page, whether from within Firefox, or when 
clicking on a web link in an application, email or game. There are two simple options: selecting 'a new 
window' means that all new pages launched will open as a new window in a separate instance of 
Firefox; the 'a new tab' option means that if Firefox is already running, any new pages launched will 
open as a new tab within an existing instance of Firefox. I strongly recommend the 'a new tab' option to 
take advantage of tabbed browsing in Firefox, and prevent lots of instances of Firefox running.

Warn me when closing multiple tabs: If ticked, this option raises a warning when you try to close a 
Firefox window containing multiple open tabs. If you're the forgetful type, or if you're used to using 
Internet Explorer and perhaps expect each page to be open in a separate window, you might want to 
tick this. Otherwise for most people I suggest unticking it for quicker closing of Firefox windows.

Warn me when opening multiple tabs may slow down Firefox: If ticked, Firefox will warn you if you 
are likely to cause slowdowns or problems in Firefox by launching too many tabs at once. For the most 
part this depends on how much memory your system has available. I suggest ticking it to begin with, as 
you shouldn't be warned unless you're truly getting to the point where there are too many tabs open and 
Firefox is using too much memory to remain responsive. At this point obviously the best option would 
be to close Firefox altogether and re-open it with fewer tabs.

Always show the tab bar: If ticked, this option forces the tab bar at the top of the Firefox viewable 
browser area to remain shown, even if only one page is currently open. If more than one tab is open, 
this option has no impact - the tab bar will be displayed anyway. I suggest you untick this option, as 
there is not much use for a tab bar if only one page is being displayed.

When I open a link in a new tab, switch to it immediately: This option determines whether pages 
launched in a new tab are shown in the foreground or the background. When you open a new tab from 



a link on the current page, if this option is unticked any new tabs opened will be in the background, not 
affecting the tab you're currently viewing. If ticked, your view will automatically switch to the most 
recently opened tab, effectively forcing all other tabs to the background.

Content
Block pop-up windows: This option should remain ticked, as it blocks 'popup' windows. Popups are 
separate browser windows which typically open up by themselves after you open a web page. They are 
most commonly used for advertising, and can vary in size and location on the screen, as well as 
frequency. However there are some sites which have legitimate popup windows (such as Internet 
Banking sites or Internet forums), and hence won't work correctly with this setting ticked. If you 
experience problems with such a site, click the 'Exceptions' button and enter the name of the site you 
want to allow popups for in the form www.sitename.com, then click the Allow button. Note that some 
spyware can also launch popups, regardless of the site you visit, so make sure you scan your system for 
such malicious software (See the PC Security chapter of my TweakGuides Tweaking Companion for 
full details). Note further that some popups are actually launched when you click on a particular field or 
area of a web page, and are specially designed to circumvent popping blocker. You can only block such 
popups if you disable Javascript for example, or install the NoScript extension.

Load images automatically: I recommend you tick this option, as it allows images to be loaded with 
web pages. Since most web pages contain images, unticking this option would see all the sites you visit 
devoid of any imagery. If however you want to choose to disable or allow images specifically on a 
website-by-website basis, you can click the Exceptions button and manually select websites which you 
can then permanently Block or Allow images from separately. Just remember that most graphical 
advertisements are actually Flash files or scripts, and not simple images, and hence this setting doesn't 
affect them. See the Extensions & Themes and Advanced Tweaking sections for details of how to 
block different types of ads.

Enable Javascript: Many sites use Javascript to produce certain effects, display certain information or 
allow a range of functionality. If this option is ticked, such sites will function correctly when viewed 
with Firefox. For that reason I recommend you leave this option ticked, as many websites will not 
display or function correctly without it. Click the Advanced button to see the types of Javascript tricks 
which you can disable. Here you can disable the more annoying effects. For example, I personally have 
all the functions listed unticked - this means all websites display correctly however they can't try any 
fancy tricks like resizing windows on me or hiding my toolbars. If you want to be more selective about 
which sites you allow to run Javascript on, see the Extensions & Themes section.

Enable Java: Java is a programming language which allows a range of functionality on websites. If this 
option is ticked, sites which require Java will usually prompt you to install the Java software if you 
don't already have it installed for Firefox. By default Firefox does not come with Java installed - this is 
because some people do not prefer their browsers to be Java-enabled. If you do want to install Java, 
then go here to download the latest version. Aside from downloading Java you have two other options: 
you can view the site with Internet Explorer which may already have MS Java Virtual Machine support 
built into it (see this site for why it may not and what you can do); or you can simply ignore the 
requirement for Java and view the site "as is". You don't have to enable or install Java if you don't want 
to, as it is not vital, but it will reduce or impair important functionality on certain sites.

Fonts & Colors: As part of customizing Firefox, you can select the fonts, colors and styles used for 
various elements of web pages displayed in Firefox. For example, if you want all Sans-serif text on 
web pages to be Arial, click the Advanced button then select that font under the 'Sans-serif' box. You 
can even set a minimum font size. You can also change the colors used for various text and links on 
web pages by clicking the Colors button.
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The important thing to understand is that most web pages already specify their default fonts and the 
styles of various elements like hyperlinks, background and text colors, etc. Therefore changing the 
settings here will typically have no visible impact. If you want your selections here to override the 
default web page options you have to untick the relevant 'Allow pages to choose their own...' boxes in 
the Advanced and/or Colors sections. For example, in the Advanced section, alter the fonts and sizes as 
required, then untick the 'Allow pages to choose their own fonts, instead of my selections above' box, 
then click OK to close this screen, and OK again to close the options. Refresh the current web page you 
are viewing and it will have changed to reflect the font and color choices you have made. Clearly most 
web pages are designed around their own font and color settings and you shouldn't override them if you 
want to view them correctly. However with a bit of testing you may happen upon a better combination 
of fonts and colors which work with all websites to better suit your tastes and/or needs.

File Types: The first time you click on certain types of files you will be asked whether you want to save 
them to disk, or open them, and whether you want your choice to become the default behavior for each 
time you click on that particular file type. Your choices are stored in this section of the Options. Click 
the Manage button and for each file type you have clicked on so far, as well as for a range of default 
file types, you will see an associated default action. If you want to change any of these, highlight the 
file type, and you can click on the 'Change Action' button to change the action, and where applicable, 
you can also click the 'Remove Action' to remove non-default file type actions. To change file actions 
in the Change Actions dialog box, you can select the application which opens that file type by default, 
and whether Firefox should open the file or save it to your computer by default whenever you click on 
a link of that type in Firefox.

In particular I recommend that you change the behavior for .zip, .rar, .pdf and .doc file types to 'Save 
them to my computer' here, as these file types usually try to automatically open up within Firefox, and 
most commonly you would want to save these files to disk rather than having them open up within the 
browser. Adobe PDF file links for example can take quite a while to load up if Firefox attempts to open 
them within the browser instead of saving them to disk. Again, make sure to save them somewhere 
other than the Desktop for memory usage reasons.

The next page continues the Firefox Settings descriptions.

5. Firefox Settings (Pt.2)
Feeds
When I click on a web feed: This option determines what happens when you click on an orange RSS 
web feed button. If you select the first option of 'Show me a preview and ask me which Feed Reader to 
use' you can select on a feed-by-feed basis which Feed reader to use. If you have a specific 
reader/application in mind for all RSS feeds, select the second option of 'Subscribe to the Feed using' 
and choose from the list below.

Privacy
Remember pages visited for the last: The addresses of the sites you visit in Firefox will be held for a 
certain number of days as a history you can refer to. If you don't want this history kept select 0 here. I 
generally recommend keeping 1 or 2 days' history however as sometimes you may want to go back to a 
non-bookmarked site you visited the day before and frustrate yourself trying to remember the site 
address.

Remember what I enter in forms and the search bar: If this box is ticked Firefox will save any details 
you enter in online forms as well as in the search bar. Unless you fill in such forms very often, for 
security purposes I recommend having this box unticked.
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Remember what I've downloaded: Every time you download a file using Firefox, it keeps a history of 
the file's location. If you don't wish this history to be kept, untick this box. In general there's no real 
reason to keep your download history, and it can also make the download manager more responsive if 
this option is unticked.

Accept cookies from sites: Cookies are small files which are placed on your computer by various 
websites. These cookies hold information which can be used by the website the next time you visit, 
such as any interface preferences you may have selected for the site, or your username and password 
for a forum, or which ads on a site you have already been shown. Cookies are mostly harmless, and 
often have legitimate uses so blocking them altogether is not wise. More details about Cookies which 
can help you separate myths from facts can be found here.

To start with, I recommend ticking this option. If you really have the time and patience, you can click 
the Exceptions button and allow or block individual sites from placing a cookie on your machine. To 
get an idea of the types of cookies already on your machine, click the 'Show Cookies' button and you 
can individually remove any which look suspicious. However if in doubt, leave the cookies untouched - 
the best way to scan for bad cookies is to regularly use an Adware scanner, which is again covered in 
the PC Security chapter of my TweakGuides Tweaking Companion.

Private Data: This section controls the way in which Firefox's 'Clear Private Data' option works. To 
start with, click the Settings button and you will be presented with a list of items which will be cleared 
each time you clear private data. Each of these options holds some aspect of your browsing history or 
other private details which you may not want others to see. On a machine which is shared with a lot of 
other people, such as a public machine, you should tick all the options. On a personal machine which 
you don't share with others, or if you have your own separate account, I suggest only ticking the items 
you genuinely feel you need to clear. Typically for example you shouldn't clear your Saved Passwords, 
as this can cause a lot of inconvenience when you have to reenter your username/password each time 
you go back to your favorite site(s). Constantly clearing your Cache can also slow down browsing too.

Once you've selected the types of data you want cleared, you can either click the 'Clear Now' button to 
clear them immediately, or you can use the 'Clear Private Data' option under the Tools menu of Firefox 
at any time in the future. If you want this feature activated each and every time you shut down Firefox 
(not recommended unless you're using a shared or public machine), tick the 'Always clear my private 
data when I close Firefox' box. If you want to be warned any time Firefox is about to clear your data, 
also tick the 'Ask me before clearing private data' - which is recommended.

For more details of common usage of the clear private data option, see the Basic Tips & Tweaks 
section of the guide.

Security
Warn me when sites try to install add-ons: I recommend you tick this option as it prevents websites 
from installing harmful or malicious add-ons without your knowledge (See the Extensions & Themes 
section). Click the 'Exceptions' button to view the sites which are allowed to install Firefox extensions 
and themes without warning - by default there are two official Mozilla sites for allowing you to 
download and install approved Extensions and Themes for customizing Firefox - addons.mozilla.org 
and update.mozilla.org. You should leave these here, however if other untrusted or unknown sites are 
listed here, highlight them and remove them.

Note: the most commonly used software you will need installed when viewing websites is Java (See the 
Enable Java setting on the previous page) and Flash - which you can download and install directly from 
Adobe. For other common plugins for Firefox, go to the Firefox Plugins secure page. For more details 
of how to install other software for Firefox and where to get it see the Extensions & Themes section in 
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this guide.

Tell me if the site I'm visiting is a suspected forgery: This setting is part of Firefox's new Phishing 
Protection feature. I strongly recommend enabling this option, as it adds another layer of protection 
against having your important data (such as bank account details) stolen. You can select the method the 
phishing protection uses: either 'Check using a downloaded list of suspected sites' which is reasonably 
reliable and has no privacy or performance impact, but doesn't protect you against very recent phishing 
sites; or 'Check by asking Google about each site I visit' which allows Firefox to use its new built-in 
Google Safe Browsing capabilities to identify suspicious sites.

In general the choice is yours, so long as you use one of the options and don't disable the anti-phishing 
featuers altogether. The advantages of using the Google option are that it provides better protection 
against a wider range of sites, since it is always kept up to date; the disadvantages are that it may add 
slightly to page load times, and also has privacy impacts, since the URL of every page you view is sent 
to Google first to check before being viewed. If you need greater security, click the second option, if 
you value performance and privacy over security, click the first option.

Passwords: If the 'Remember passwords for sites' box is ticked, whenever you enter a username and 
password on a web page, you will be given the option to record that username/password combination. 
The next time you go to the same site your username will automatically be filled in, and the password 
will also be filled in as a series of *****. This speeds up logging into sites, however it is obviously a 
security threat if you share the computer, so untick this option if security is the major concern.

To view the currently stored usernames and passwords (and the sites they relate to), click the 'Show 
Passwords' button. This opens a box which shows every combination of username/password you've 
entered on a particular site. To view the actual passwords for each username, click the 'Show 
Passwords' button at the bottom of the box. You can highlight and Remove all incorrect or unnecessary 
username/password combinations as required. If you want to protect yourself from other users who 
may view your password list, click the 'Use a master password' option and then enter a master 
password. Note that the more letters and numbers the password contains, the stronger it will be as 
indicated by the password quality meter at the bottom of the master password dialog box. Now 
whenever you click the Show Passwords button you will have to enter this master password to gain 
access.

Warning messages: As you use Firefox in a variety of situations you may see a range of warning 
messages which state obvious but important facts. You can disable these messages at the time they're 
shown, or you can click the Settings button here and tick/untick which messages you want shown on a 
regular basis. For the most part none of these warnings is absolutely vital and can be unticked as long 
as you're vigilant about your general browsing.

Advanced
General
Always use the cursor keys to navigate within pages: When ticked you can use the arrow keys on the 
keyboard to move the cursor on the current web page. You can then use the SHIFT key along with the 
arrows to highlight portions of text. This is the same as if you were using the mouse by highlighting 
portions of text with the mouse cursor and using the left mouse button to begin/end selections. Set to 
suit your tastes, however note that firstly you may have to click on a portion of a site to initiate the 
cursor, and secondly, if enabled this option may force a flashing cursor to appear on many web pages 
even without being clicked on, which can be annoying.

Search for text when I start typing: If ticked, this option allows you to initiate a search in Firefox 
simply by typing one or more letters. That is, if you start typing the search box automatically appears at 
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the bottom of the screen and accepts your input for a new search. If unticked, you will have to press the 
Find shortcut key (usually F3 or CTRL+F) to open the search box. I suggest you tick this option to 
begin with, and if you find it annoying then untick. See the Customizing Firefox and Advanced 
Tweaking sections for more details of ways to speed up searching.

Use autoscrolling: If ticked this option enables Autoscroll - this lets you scroll the page quickly by 
holding down the middle mouse button and moving your mouse up or down. I suggest ticking it 
initially, then untick it if you find it annoying.

Use smooth scrolling: If ticked, Firefox uses Smooth Scrolling. This means that when the page scrolls 
up or down, it doesn't jump from one place to another - it scrolls slightly more slowly, allowing your 
eyes to track your existing position to its new spot. Ticking this option makes reading long passages of 
text (such as this page) easier. However it can also make some pages seem 'laggy', so keep this in mind 
and disable it if it makes your browsing feel less responsive.

Check my spelling as I type: A new feature of Firefox 2.0 is the built-in spell checker. If this option is 
ticked, the spell checker will automatically check the spelling of text entered in any text input boxes on 
the screen and underline in red any words which are misspelled. You can then right-click on the word 
to see suggested spellings and select one, or you can add the word to the current dictionary used. For 
the most part I recommend that you enable this option, as it is very useful. The dictionary used depends 
on the particular version of Firefox you're using. This feature may slow down browsing on pages which 
have a text input box filled with a vast amount of text, but for the most part there is negligible 
performance impact. For more tips on using this feature, see the Basic Tips & Tricks section.

Languages: Some (not all) web pages offer different language versions which display by default when 
you view them. Add/Select which language you want pages to display with by default if they offer such 
an option. Remember that if you want a different language version of Firefox, for correct spell 
checking for example, you need to install the appropriate version to begin with (See The Basics section 
above).

Network
Connection: This setting is very important, and if you need help configuring it correctly contact your 
Internet Service Provider (ISP). If configured incorrectly you will have problems accessing web pages 
and/or you may have relatively slow loading of pages. Click the Settings, and for most people, the 
'Direct connection to the Internet' option is the recommended one. However if you are behind a Proxy - 
which is normal for networked computers for example - then select the 'Auto-detect proxy settings for 
this network'. This choice might also be preferable if you don't know whether you are or aren't behind a 
proxy. If possible, check this with your ISP or Network Administrator. If you are definitely behind a 
proxy, it is recommended that you manually specify your proxy settings for even better performance, 
but once again you require specific information from your ISP or Network Admin to do this.

Cache: The browser cache is a location on your hard drive where Firefox holds website elements such 
as images, text, ads etc. This speeds up browsing, because when you revisit these sites, the cached 
version of the unchanged elements are loaded from your hard drive as opposed to having to redownload 
them again over the Internet. It is best to make the cache size not too large so that it takes a while for 
Firefox to search through it to retrieve the right elements, and not too small so that it is constantly being 
overwritten by new information. I suggest something like 80MB as a good compromise value for 
everyone. I don't recommend the cache be any larger than 100MB - unless you have a very fast hard 
drive; and no smaller than 10MB - unless you have a very fast Internet connection combined with a 
very slow hard drive. See the Customizing Firefox section for more details about the Browser Cache.
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Update
Automatically Check for Updates to: Here you have the option of enabling Firefox's automatic update 
checker. If you tick the Firefox box, Firefox will periodically check for Firefox updates and tell you if 
it has found a new version of itself. If you tick the 'Installed Add-ons' box, Firefox will periodically 
check for updates to your currently installed extensions and themes and let you know when new 
versions of those are available. The 'Search Engines' option checks for updates to the built in search 
engines in Firefox. I suggest you tick all three of these options so that you can be reminded of updates 
in case you don't manually check regularly. You should always run the latest version of Firefox 
software and any add-ons to ensure maximum security and stability with Firefox, and with the built-in 
updating features of Firefox, installing updates is quick and easy and doesn't require manually 
downloading separate files.

When Updates to Firefox are Found: If you enable the automatic updates checker, you can choose here 
what Firefox should do when it finds an update. You can either force it to 'Ask me what I want to do', 
or allow it to 'Automatically download and install the update'. I recommend the first option, so that you 
can choose when to install updates at the most appropriate time, so as not to interfere with other 
downloads or applications using your Internet connection.

If you don't want the automatic update checker to do its job, untick all the automatic update options, 
and to manually check for updates at any time, regularly visit the Firefox Home Page, the Firefox 
Extensions Page, and the Firefox Themes Page. However this is generally not recommended.

Encryption
Protocols: The options here are 'Use SSL 3.0' and 'Use TLS 1.0'. I recommend that you tick both 
options, as they use appropriate security protocols (SSL is Secured Sockets Layer and TLS is Transport 
Layer Security) to ensure secure transmission of data over the Internet. If you encounter any difficulties 
with a particular website, then untick 'Use SSL 3.0' first, then 'Use TLS 1.0'. If you still have 
difficulties, avoid using the site for entering sensitive data, as all sites should support SSL 2.0.

Certificates
When a web site requires a certificate: This setting determines how Firefox reacts to a request by a 
website to present a Certificate. Certificates are used to verify identity and/or provide authorization for 
secure transmissions. You should always select 'Select one automatically' to allow Firefox to determine 
the appropriate Certificate to present. If you know what you are doing or you are having difficulties 
accessing certain secure sites, you may wish to select 'Ask me every time' and manually select a 
Certificate.

View Certificates: Clicking this button brings up a box which allows you to add or remove various 
types of Certificates - those which are yours, those of others, those of web sites you visit, and those of 
authorities which verify certificates. In general you shouldn't need to change these settings unless you 
know what you're doing.

Revocation Lists: CRL is your Certificate Revocation List - a list of Certificates which are no longer 
valid. Firefox can use such a list if you need to add one, however as with the other Certificate options 
in Firefox, this is not something you need to adjust unless you are familiar with this functionality.

Verification: OCSP is the Online Certificate Status Protocol, another tool to determine the validity of a 
Certificate. If you require advanced security, you can enable OCSP by selecting the 'Use OCSP to 
validate only certificates that specify an OCSP service URL', or if you want even more advanced 
security select 'Use OCSP to validate all certificates using this URL and signer', then select the service 
to use. I strongly recommend you leave OCSP on the 'Do not use OCSP for certificate validation' 
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setting otherwise you may run into problems.

Security Devices: Clicking this button allows you to manage the tools which give you secure access. 
There are two which are built into Firefox, but you can manage or use others which are installed on 
your system. Once again there is no need to change these settings unless you know what you're doing.

The next section provides a range of basic - but important - tips and tricks you can use to improve your 
Firefox experience quickly and easily. These are perfect for the beginner and advanced user alike.

6. Basic Tips & Tweaks
This section covers some basic yet important tips and tricks you can try to make using Firefox more 
convenient. Beginner users should definitely not skip this section, but even Advanced users who may 
already be aware of the majority of these might find some tips theey haven't yet seen.

Streamlined Firefox Layout
To provide maximum viewable space in the Firefox browser window, many people use a streamlined 
Firefox layout which I will detail here. The difference between the default and the streamlined view is 
shown below:

 

As you can see, the streamlined view retains all the main functionality of Firefox, but reconfigures the 
layout to be as minimal as possible. Follow these steps to implement it:

1. Open Firefox, go to the View menu, select Toolbars and untick the 'Bookmarks Toolbar' item.

2. If you have a Sidebar showing, under the View menu select Sidebar and unselect any items.

3. Under the View menu select Toolbars and then select Customize. Alternatively you can right-click 
on an empty spot on a toolbar and select Customize.

4. In the 'Customize Toolbar' box which appears, select Icons in the Show box (not 'Icons and Text', or 
Text). If you're running a lower screen resolution also tick the 'Use Small Icons' box.

5. Now remove every icon or element in the Firefox toolbar at the top of the browser which you don’t 
need. For example, drag and drop the Search box into the 'Customize Toolbar' box to remove it from 
the Firefox toolbar. Do the same for any other icons/elements which you feel are unnecessary, such as 
the large white space filler at the top right of the Navigation toolbar. You can always re-add these 
elements at any time if you change your mind later on.

6. Now drag and drop each icon in the bottom Firefox toolbar up to the top toolbar, just to the right of 
the 'Help' menu item. This includes the large white Address box. The aim is to have everything on a 
single toolbar.

7. Insert any additional icons, separators or blank spaces you need from the selection shown in the 
'Customize Toolbar' box into the relevant spots on the top Firefox toolbar. When finished, click the 
Done button.

8. Finally, go to the View menu, and under Toolbars unselect the 'Navigation Toolbar' as it should now 
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be completely empty anyway.

You should now have a single Firefox toolbar at the top of your browser, complete with all the menu 
commands, relevant icons and the address box. This gives you more vertical viewable space (and a 
substantial amount of horizontal space if you had a sidebar showing). If you need more, go to the View 
menu and untick the 'Status Bar' item as it is not vital, and provides a further bit of vertical viewable 
space.

Obviously this layout may not suit everyone, and can be modified to suit your taste. However once you 
get used to it, it is extremely efficient and provides maximum viewable space in Firefox. Note that you 
can further customize the layout by looking under the Advanced Tweaking section.

Tabbed Browsing
The most famous features of Firefox is Tabbed Browsing. This is a feature which allows users to open 
up a link as a new tab within their current Firefox window, rather than opening up an entirely new 
Firefox window. The benefits of this are faster loadup times for pages opened as tabs, less overall 
system memory usage, less buttons for open instances of Firefox on the Windows Taskbar, the ability 
to load pages in the background while reading the current page, and the convenience of being able to 
switch back and forth between pages just by clicking their tab. For more details of this feature read this 
brief Tabbed Browsing Overview.

Opening, Closing and Switching Tabs: Whether you use tabbed browsing or not is up to you, however 
it is generally recommended that you do, and there are some basic things you can do to make better use 
of this feature:

To open any link as a new tab you simply need to click your center mouse button while pointing to a 
link. If you don't have a center mouse button, hold down the CTRL key then left-click on a link to get 
the same result. 

• If you want to force a link to open as a new tab in the foreground, you need to hold down the 
SHIFT key and use the relevant methods above. 

• If you want to close a tab quickly, simply click the center mouse button on the tab, or press 
CTRL + W or CTRL + F4 while viewing the tab. Or you can just click on the red 'X' on the tab 
itself. 

• To switch quickly between open tabs, press CTRL + Tab Key to go to the next open tab, or 
SHIFT + CTRL + TAB Key to go to the previous open tab. 

• If you want to go to a specific open tab, press CTRL and a number key corresponding to that 
tabs position from the left. For example, pressing CTRL + 2 will jump to the second open tab. 

• You can rearrange the order of open tabs by dragging and dropping them.

In fact, if you click your middle mouse button on a range of things in Firefox, they will typically open 
up in a new tab (substitute CTRL for middle-click). For example, click the middle button on the back 
or forward arrows at the top of Firefox, and the previous or next pages you've visited will open in a 
new tab. Middle-click on an item in your history or your Bookmarks and it will open in a new tab. 
Middle-click on the Homepage toolbar icon and your home page will open in a new tab.

Note that as of Firefox 2.0, once a certain number of tabs are opened, the tabs start to shrink in width 
and at a certain point no more tabs will be shown on screen. Instead a small dropdown button at the far 
right of the tab bar can be clicked to show a listing of all open tabs. For more ways of customizing tabs 
and tabbed browsing see the browser.tabs.-related preferences in the Advanced Tweaking section.

Faster Searching
There are several ways you can speed up searching web pages and searching on the Internet using 
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Firefox:

Search for text when I start typing: I recommend that you have the 'Search for text when I start typing' 
setting ticked (See the Settings section above). That way you can initiate a word search on the currently 
viewed web page simply by starting to type the search string on your keyboard without having to first 
bring up the search box. The first instance of that word will automatically be highlighted in green on 
the page. To find more instances of the word(s), keep pressing the F3 key. Note that the last search 
string you entered is kept in memory, and simply pressing F3 on any other page initiates the same 
search again. Pressing ESC closes the search box, but it also closes automatically if you click anywhere 
else in the Firefox window. For more ways of customising this function, see the 
accessibility.typeaheadfind.-related preferences in the Advanced Tweaking section.

Keyboard Shortcuts: Another way to quickly open the search box is to use the keyboard shortcuts F3 or 
CTRL+F. You can quickly close the search box by pressing the ESC key at any time.

Selection Web Search: Highlight a portion of a web page by holding down the cursor over the start of 
your selection, then left-click and drag the cursor to the end of your selection and release the mouse 
button. Now right-click on this highlighted selection, and in the context menu select the 'Search Google 
for...' item. Firefox will automatically launch a web search using your the default search plugin Google 
and provide the results in a new tab/window.

Web Search Box: You can use the dedicated Web Search box in your Firefox toolbar to speed up 
searching for information on the Internet. If it isn’t already there, to add it in go to 
View>Toolbars>Customize and in the 'Customize Toolbars' box find the white Search box, and drag 
and drop it into a suitable position on your Firefox toolbar, then click Done. Next, click on the small 
icon in the left side of the search box, and select the search engine you wish to use for web searches - 
Google is the default and recommended engine, although you can use a more specific site such as 
Answers.com or Ebay.com for example. Now enter the phrase(s) you wish to search for in this Search 
box and press Enter - the results will be displayed in the main Firefox browser window.

Note that as of Firefox 2.0, the search box also has search completion on by default. This means that as 
soon as you start typing a search phrase into the box, suggested variations will appear in a drop box 
below it. You can then select any of these variations if you wish to search for that phrase, or continue to 
finish what you were typing. If you don't like this feature, right-click in the search box and unselect 
'Show Suggestions'.

You can download additional plugins for the Web Search box by clicking on the Search icon next to 
the Search box, selecting 'Manage Search Engines' and then clicking the Get more search engines link 
at the bottom. Alternatively, you can go here to find other engines. You can also create your own 
custom search. Since all the search engine coding is saved in your \Program Files\Mozilla  
Firefox\searchplugins\ directory as .xml files, you can create your own .xml file which will allow you 
to use the Search box to launch a search on any site you wish. Full instructions are here.

Address Bar/Keyword Searches: One of the fastest ways to search is by using keywords within the 
Firefox address bar. By default if you enter a word in the Firefox address bar it will attempt to find the 
closest matching web page for that word (using Google's 'I'm Feeling Lucky' search by default) and 
open up the site. If you want to add the Web Search functionality (covered above) directly to the 
Address bar, simply right-click in any search box on a web page and select 'Add a keyword for this 
search'. Note you can jump to the address bar quickly at any time by pressing CTRL+L. This moves the 
cursor to the address bar and highlights all existing text in there.

Further ways to customize searching behavior are in the Advanced Tweaking section of the guide.
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Always Viewing the Latest Content
Force Reload: By default Firefox does not automatically re-download the entire contents of a web page 
every single time you visit the page. It will first try to detect if the page content has changed 
significantly from any stored versions of the same page it holds in your browser cache. This is fine 
since most websites don't change their content every minute or even every hour. However often 
webmasters may change small parts of the site, update only a tiny portion of a page, or even one or two 
important words in the text body, and Firefox will not show the updated page for a day or two. For 
example I regularly update my guides on TweakGuides.com and users write to me saying they still 
only see the old version. To remedy this, there is a simple way you can make sure Firefox loads up the 
latest version of a web page at any time: simply press CTRL+F5, or hold down the SHIFT key and left-
click on the Reload icon. This forces Firefox to reload every part of the currently viewed page from the 
Net and not your cache, ensuring every part of the content you're viewing is the latest available. Use 
this method at any time if you believe you are viewing an old version of a page.

See the Advanced Tweaking section for more details of how to change this Firefox behavior 
permanently for every web page viewed.

Spell Checker
One of the prominent new features in Firefox 2.0 is the integration of a spell checker. This might seem 
confusing at first, however the aim of the spell checker isn't to check the spelling on web pages you're 
viewing, it's to check the spelling of any text boxes in which you can enter text. For example, if you're 
posting on a Forum, or entering text into an online form or search box, by enabling the spell checker 
('Check my spelling as I type' option found under Tools>Options>Advanced>General>) any spelling 
mistakes you make will be underlined in red. Right-clicking on these underlined items will show you 
suggested alternative spellings which you can click on to use instead, or if the word is correct, you can 
ignore the spell check, or select 'Add to Dictionary' and it will be stored and not flagged as being 
misspelled in the future.

Some text entry boxes however do not have spell checking enabled by default. To enable spell 
checking in any text entry box on a web page temporarily, right-click in the box and select 'Spell check 
this field'. To enable spell checking in all text boxes permanently, see the Layout.spellcheckDefault 
preference in the Advanced Tweaking section. Furthermore, ideally you should have downloaded the 
correct language version of Firefox for your region (see page 3), as this affects the specific dictionary 
that Firefox uses by default. For example if you downloaded the English US version of Firefox and you 
live in Australia, it will falsely pick up some Australian spellings as incorrect. Furthermore dictionaries 
for certain regions are not automaticaly built into Firefox. To add new dictionaries to your existing 
version of Firefox, right-click in a spell-checked field and select Languages>Add Dictionaries. You can 
then install a new dictionary, and select which to use under the Languages menu item in the spell 
checker.

The spell checker generally does not affect performance, however note that on pages which have 
editable text boxes containing a very large amount of text, this can cause a slowdown as Firefox checks 
for errors. To reduce this problem see the extensions.spellcheck.inline.max-misspellings preference in 
the Advanced Tweaking section. In general though there should be no real reason to ever disable the 
spell checker.

Bookmarking
Your bookmarks are web pages whose URL addresses you have stored so that you can return to these 
pages quickly and easily just by clicking on their bookmarks. This is identical to the Favorites feature 
in Internet Explorer. However there are some neat things you can do in Firefox to make your 
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bookmarks far more useful.

Sorting Bookmarks: To quickly sort your bookmarks at any time, go to the Bookmarks menu of 
Firefox, right-click anywhere on your list of bookmarks and select 'Sort By Name' - they will be 
alphabetically sorted by the name of the bookmark, with folders first, and standalone bookmarks below 
them. You may have to do the same thing again for the contents of each folder.

Keywords: To start with, if you want to rapidly access your bookmarks, go to the Bookmarks menu, 
right-click on the bookmark and select Properties. In the Properties box which opens, you can assign a 
shortcut to this bookmark in the Keyword box. For example, if you have TweakGuides.com 
bookmarked, enter "t" (without quotes) in the Keyword box, and click OK to close the box. Now the 
next time you want to quickly load up TweakGuides.com, go to the address bar and simply type the 
letter "t" (without quotes) and press Enter - the TweakGuides.com front page will load up straight 
away. You can assign custom keywords - whether a single letter or an entire word - to each of your 
favorite bookmarks and use them in the address bar in a similar way. If you assign a Keyword to a 
search engine search result, you can use it to speed up searches as well - see the Faster Searching tips 
above for details.

Bookmarking Multiple Tabs: If you want to quickly bookmark several open tabbed pages, open all the 
tabs you want to bookmark, then go to the Bookmarks menu in Firefox and select 'Bookmark all tabs', 
and give the new folder a name. The next time you want to open all the sites listed in the folder, go to 
that bookmarked folder, right-click on it and select 'Open all tabs'.

Live Bookmarks: If you visit websites which have RSS feeds, such as news and blog sites, you can 
bookmark them as 'live' bookmarks. To do this, just click on the orange RSS icon in the bottom right of 
your Firefox window (note: you must have the Status Bar visible to see this icon). From there, you can 
select the type of RSS subscription, and the bookmark will be added with a sub-folder which has all the 
latest articles from that site as a live feed. For more details go here. By default Firefox 2.0 has one such 
bookmark under the 'Latest Headlines' folder.

Bookmark Add-ons: If you want to do more with Bookmarks, go to your Bookmark menu and select 
the Get Bookmark Add-ons item.

There are further tips to improve bookmarks in the Advanced Tweaking section.

Clear Private Data
This feature of Firefox is covered in the Firefox Settings section of this guide, however basically it 
allows you to quickly remove a range of personal data from the browser in one go. Again, for more 
details of how to configure it, see the Firefox Settings section on the previous pages. Aside from 
accessing it from within the Firefox Options, you can also access it on your Firefox menu, under 
Tools>'Clear Private Data', or by clicking CTRL+SHIFT+DEL together. If you use this function often, 
untick the 'Ask me before clearing private data' box. Now whenever you use the menu option or press 
the keyboard shortcut for this function, it will occur instantly without asking you to confirm any 
options. If you want to automatically clear relevant private data each time you close Firefox, that too is 
possible if the 'Always clear my private data when I close Firefox' option is ticked in the Firefox 
Options screen.

Keyboard and Mouse Shortcuts
Aside from those mentioned here, there are a range of keyboard and mouse shortcuts you can use to 
speed up browsing and to access special features in Firefox. Whether you use them is up to you, 
however I often find that there a handful of shortcuts which are very useful in any program. Take the 
time to give a few of these a try and you may find they make using Firefox even quicker. To see a 
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complete list of various keyboard and mouse shortcuts you can use in Mozilla, see this Keyboard 
Shortcuts List and Mouse Shortcuts List.

That covers the basic but generally more handy tips and tweaks in Firefox. This is just the tip of the 
iceberg however, as there are a large number of ways in which Firefox can be customized and tweaked, 
and these are covered in the next two sections.

7. Customizing Firefox
Before you start any advanced tweaking of Firefox, it's important to understand Firefox's structure and 
where it stores different types of customizations, as well as the different methods by which you can 
apply various customizations and tweaks. The main areas of Firefox which hold your different 
customized settings are each covered in detail below. Familiarize yourself with the information below 
before attempting to undertake any tweaking.

Profiles Manager
Firefox saves all of your custom settings in a Profile. This profile is typically held under your 
\Documents and Settings\[Username]\Application Data\Mozilla\Firefox\Profiles\ directory. Each 
profile directory is named with a string of letters and numbers, followed by the actual profile name (e.g. 
pj8faz9p.default). Each profile holds its own customized settings, and when a profile is deleted, all 
changes - whether made using the Firefox settings screen or in About:Config - will be removed.

Before making any of the changes in this guide, you should make a quick backup of your current 
Firefox Profile. This will allow you to quickly and easily return everything to the way it was before you 
started tweaking in case things go wrong. Don't skip this step as it will save you a lot of frustration, as 
many tweaks can't be easily "undone". The simplest way of making a backup of your profile(s) is to 
copy everything under the \Profiles directory (as shown above) to another location. You can then 
"restore" this backup at any time by copying it over existing profile(s) in the same directory.

Alternatively, if you want to create an entirely new profile so that you can safely test some tweaks for 
example, or simply to start tweaking from scratch, you can do so by using the Firefox Profile Manager. 
To access the Profile Manager, first close all instances of Firefox (otherwise profile manager won't 
work), then go to Start>Run and type "Firefox.exe -profilemanager" (without quotes) and hit Enter. 
From here you can create a new profile, or delete or rename existing profiles.

Remember, if you just want to restore Firefox back to its original default settings at any time, you can 
use the profile manager to first create a new profile (which automatically uses the default settings) then 
double-click on that new profile name to use it in Firefox. The next time you open Firefox it will be at 
its default settings again.
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Bookmarks Manager
In Internet Explorer your stored bookmarks are better known as Favorites, and held under your 
\Documents and Settings\[username]\Favorites\ directory. In Firefox, your bookmarks are held 
separately under your Profile folder as the file Bookmarks.html. There is nothing more frustrating than 
losing all your bookmarks, so regularly back them up by doing the following:

1. Go to the Bookmarks menu and select 'Organize Bookmarks'.

2. In the new Bookmarks Manager window which opens you can see all of your current bookmarks 
arranged under various folders. You can rearrange, rename or delete any of these just as you would 
using the Windows Explorer interface (i.e. drag and drop).

3. Once done, to back them all up select the File menu in this box and choose Export.

4. Select a directory where you wish to backup the Bookmarks.html file - this file contains all your 
current Firefox bookmarks for the active profile.

5. To restore these saved bookmarks at any time, select File>Import under the Bookmarks Manager, 
select 'From File' and point it to where your backed up Bookmarks.html file is stored.

Note that Firefox itself regularly backs up your Bookmarks to the \bookmarkbackups folder under your 
profile, in case you suddenly need to restore an earlier version of your bookmarks. You can import any 
of these backups using the instructions under Step 5 above.

You can also import your Internet Explorer bookmarks (or those from another installed browser) into 
Firefox at any time by selecting Import under the File menu in the Bookmarks Manager screen. 
Bookmarks imported from Internet Explorer will be imported and stored separately under a new folder 
called 'From Internet Explorer' - they won't overwrite your existing bookmarks in Firefox.

Cookies, History, Passwords
Firefox stores your cookies in the automatically generated file cookies.txt under your specific Profile 
folder; your viewing history is saved in the file history.dat; and your saved login and passwords are 
kept in the file signons.txt file in the same folder. You can view the contents of all of these files using a 
text editor like Windows Notepad, however most of the contents will not make much sense. Username 
and passwords in the signons.txt file for example are encrypted for security purposes. If you want to 
back these up, I strongly suggest backing up your entire profiles folder, rather than these individual 
elements, as there are several other files which are required to make a profile function correctly.

If you simply want to import cookies, history or username/passwords from Internet Explorer at any 
time, you can once again use the Import option under the File menu in Firefox.

Cached Files
As mentioned in the Settings section above, the Firefox browser cache is a location on your hard drive 
where Firefox stores website elements such as images, text, ads etc. This cache speeds up browsing 
because when you revisit sites, the cached version of the unchanged elements are loaded from your 
hard drive as opposed to having to redownload them again over the Internet. Note the cache doesn't 
store elements such as cookies, passwords etc - these are stored separately (See above for details). The 
cache also doesn't store secure website elements by default, clearly for security purposes.

The location for cached Firefox web elements is under the \Documents and Settings\[username]\Local  
Settings\Application Data\Mozilla\Firefox\Profiles\[profilename]\Cache directory, however the files 
held there are saved as a range of alphanumeric strings and not as filenames. This is primarily for 
security purposes, so that a malicious file/script in your cache can't be launched easily. To view the 
cache contents, type "about:cache?device=disk" (without quotes) in the Firefox address bar and press 



Enter - all the cached entries will be shown as links, with further details when you click on each link.

If you really want to retrieve something from your cache, such as a large picture, document or flash 
animation, use the about:cache?device=disk method mentioned above, then search for the site or 
filename. Once you find the correct link, click on it and on the details screen which follows, look at the 
'File on Disk' field towards the bottom - it will show you the path to the exact file in the cache which 
contains that element. You can then copy the cached item(s) across to another location on your hard 
drive, and rename them back to their original filename. Obviously this can be very risky if you're not 
sure about the legitimacy of the cached element, so you should only do this if you really need the file - 
be very careful as some cached items may be spyware or trojans - always run a couple of malware 
scanners on the particular file before opening or executing it.

Prefs.js & User.js
There is a file called Prefs.js in each profiles folder which holds most of the Firefox preferences you set 
in the Tools>Options menus. This file is automatically generated by Firefox and updated whenever you 
make changes in the Options menus. You should not need to manually edit this file - instead if you 
want to add customized preferences to Firefox outside of those available in the Options menus, there 
are two preferred ways in which you can do this.

Firstly, you can create a new file in the same directory as Prefs.js called User.js. To create this file, 
open Windows Explorer, go to your Profiles directory, and under your current profile's directory - in 
the same directory as Prefs.js - right-click in an empty spot in the right pane and select New>Text 
Document. You can now edit this file using a basic text editor like Windows Notepad and manually 
insert commands in the file. Once done, right-click on the text document and rename it to User.js (not 
User.js.txt).
However, there is an easier way to customize the majority of Firefox's preferences - both the readily 
available ones and those which are usually hidden. That method is known as the 'about:config' method 
and is covered separately below.

The main uses for Prefs.js and/or User.js would be if you wanted to backup or copy across your custom 
tweaks to another machine and/or to another install of Firefox, or if you want to manually delete 
about:config entries you've changed. Note that if you want to edit Prefs.js and/or User.js you should 
always close all open instances of Firefox first before opening either of these files in a text editor, 
otherwise your changes will not be properly saved or implemented in Firefox.

About:Config
To quickly and easily access a whole range of customizations and preferences for Firefox, simply open 
Firefox then go to your Firefox address bar and enter the URL "about:config" (without quotes), then 
press Enter. Instantly Firefox displays a large range of preferences sorted alphabetically. There are 
three types of preference variables shown here: Integers, Boolean and String variables. An Integer 
preference can only take a whole number value; Booleans can only take true (on) or false (off) values; 
and Strings can consist of any combination of letters, numbers and characters. You can change the 
value of these settings quickly by double-clicking on them: Booleans will toggle from true to false (or 
vice versa) and back; Integers and Strings will open a dialog box which allows you to input a new 
value. Or you can right-click on a preference and select Modify or Toggle as relevant.

We cover the major preferences, both those which are already shown under about:config, and some 
which we need to create, in the Advanced Tweaking section of this guide starting on the next page.

Importantly, any changes made using the about:config method are stored in the Prefs.js file in your 
Profile folder as mentioned above. You should backup this file before using the about:config method as 



a precaution, because changes using about:config cannot be "undone" without restoring or editing the 
Prefs.js file. If you didn't backup the file before making changes, you can manually edit Prefs.js with 
any text editor to remove the line(s) containing the altered preference, and it will be reset back to its 
default. And as always, any settings already available in the normal Firefox Options menus are best 
changed from within Firefox, not using about:config or any other method.

UserChrome.css
This file is a style sheet which controls the Firefox interface, and we can insert various commands into 
it to modify the way Firefox looks beyond the settings available in the Options menu. This file doesn't 
normally exist in your Profile folder, so you will have to create a new text file in the \Chrome 
subdirectory of your relevant Profile folder and rename it to UserChrome.css, then edit it with a text 
editor. Alternatively, you can copy and rename the UserChrome-example.css file already in that folder 
and edit it.

UserContent.css
As with UserChrome.css above, UserContent.css is another style sheet which controls the way in 
which web pages appear in Firefox. This file also doesn't exist by default in your Profile folder, and 
you will have to create a new text file and call it UserContent.css in the \Chrome subdirectory of your 
relevant Profile folder, or copy and rename the UserContent-example.css file already in that folder and 
edit it.

Note that you should close all open instances of Firefox before editing UserChrome.css or 
UserContent.css, otherwise your changes may not be implemented.

Various useful UserChrome and UserContent-based customizations, as well as all of the important 
About:Config preferences are covered in the Advanced Tweaking section on the following pages.

8. Advanced Tweaking
This section primarily covers advanced tweaks you can perform in Firefox by editing/changing 
preference values and style sheets. It's a bit trickier than the tips covered in the rest of the guide, but the 
results are also much more noticeable. Before you start this section you must read the Customizing 
Firefox section on the previous page to understand how the tweaks in this section are applied. If you 
run into any problems or find the tweaks not working, I urge you to re-read both the Customizing 
Firefox section, as well as going through my TweakGuides Tweaking Companion because it is likely a 
problem with your system setup or your understanding of how customization/tweaking works in 
Firefox.

Note that many of the advanced tweaks in this section can probably be applied using one of the many 
Firefox Extensions available, so see the Extensions & Themes section below if you want to try those 
first. For most people however I recommend getting used to manual tweaking, since it is the best way 
of understanding what's going on "under the hood" of Firefox. Also note that these tweaks have been 
summarised and refined by me from a much larger collection of possible tweaks, therefore this is not a 
comprehensive list of every possible tweak for Firefox - all the important tweaks are covered here; 
most of what has been left out are more obscure/less commonly used tweaks.

http://www.tweakguides.com/TGTC.html


 

About:Config Preferences
This section contains the instructions on how to conduct advanced preference tweaking in Firefox. 
Preferences which can be completely changed using the in-browser Options menus are not covered 
below - see the Firefox Settings section of the guide. Please read the notes below carefully before 
tweaking your About:Config:

• Some preferences are not in About:Config by default. These are denoted with a *Create tag. If 
you cannot find a preference mentioned below in your own about:config listing you will have to 
create it as a new preference. To do this, right-click on an empty spot in the About:Config 
screen, select New and then select the type of preference as specified, then give it the name 
exactly as shown here, and the appropriate value.

• Preferences which you have altered at any point (whether manually, or within the Firefox 
settings) will appear in bold in the About:Config screen and have a status of 'User Defined'. 
Those which are still at their default setting will be unbolded and have the status 'Default'. To 
reset a preference to its default configuration, right-click on it and select Reset.

• To undo the effects of a mistakenly entered or undesirable custom-created preference, right-
click on it and select Reset, then close all instances of Firefox and restart it. This doesn't remove 
the actual preference from About:Config however, so to remove it from the listing go to your 
Prefs.js file (See the Customizing Firefox section), do a search for the preference name, 
highlight that entire line it's on and delete it altogether, then close and save the file. Go back 
into About:Config and it should no longer be there.

• Many preferences which have tempting names are legacy items from previous builds of Firefox 
and do not work (e.g. the browser.turbo.enabled setting does nothing).

• There are far more preferences which you can change using About:Config than the ones listed 
here - I've only tried to cover those which have a major impact or are more commonly used. For 
a full list of preferences refer to the following articles:

Mozillazine About:Config Entries

Mozdev.org Documented Preferences

Mozilla Network Preferences

There are also other About: commands you can use, such as About:Cache and About:Plugins to show 
you more information about your current build of Firefox - more details of these here.

http://en.wikipedia.org/wiki/About:
http://www.mozilla.org/quality/networking/docs/netprefs.html
http://preferential.mozdev.org/preferences.html
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New in Firefox 2.0
The following new preferences have been added to this list as of Firefox 2.0:

browser.sessionhistory.max_total_viewers
browser.tabs.closeButtons
browser.tabs.tabclipWidth
browser.tabs.tabminWidth
extensions.checkCompatibility
extensions.spellcheck.inline.max-misspellings
Layout.spellcheckDefault
All the other preferences have been updated for Firefox 2.0 (as some of them have changed behavior 
slightly), and several new preferences have been added to the list which are not necessarily new to 
Firefox 2.0.

The preferences list below is presented in alphabetical order with the full name in italics, type in [ ] 
square brackets, any recommended values in ( ) round brackets, whether it needs to be created *Create, 
followed by a brief description. Recommendations are given for some of the settings, but not for all - 
you will need to experiment as the choice is often based on personal taste and/or your specific Internet 
connection speed. To make sure your preference changes are saved and/or to test the effects of a 
preference change, close all open Firefox windows and restart Firefox.

If you think I've missed any important preferences, please Email Me.

accessibility.typeaheadfind.casesensitive [Integer] - If set to 0, searches using 'Find as you type' are not 
case sensitive, if set to 1 they are case sensitive.

accessibility.typeaheadfind.linksonly [Boolean] - If set to true, this setting makes the 'Find as you type' 
feature search only for links on a page.

accessibility.typeaheadfind.enablesound [Boolean] (False) - By default this is set to true, which means 
the 'Search for text when I start typing' feature makes a noise each time you enter characters in a string 
which is not found on the current page. To turn this annoying sound off, set this option to False.

alerts.totalOpenTime [Integer] (2000) - Determines for how many milliseconds to show the 'Download 
complete' or 'Updates Available' alerts. I recommend reducing this to 2 seconds (2000).

app.update.interval [Integer] - If you've enabled automatic checking for Firefox updates in the Options 
menus, this setting determines how many seconds Firefox will wait between checking for updates (at 
the URL contained in the app.update.url preference). The default is 24 hours (86400 seconds).

browser.bookmarks.livemark_refresh_seconds [Integer] *Create - This is the number of seconds 
Firefox waits between checking for updates to any Live (RSS) Bookmarks you may have. The default 
is 3600 seconds = 1 hour, and for most purposes this is fine.

browser.cache.check_doc_frequency [Integer] (3) - This setting determines how often Firefox checks 
for newer versions of the page you are viewing. This setting is similar to Internet Explorer's 'Check for 
newer versions of stored pages' setting. If set to 0 Firefox only checks once per browser session; if set 
to 1 Firefox checks every time a page is viewed; if set to 2 Firefox never checks (i.e. it always uses the 
version stored locally in your browser cached); and if set to 3 (the default) Firefox checks at 
automatically determined intervals. If you browse mostly pages which update their content extremely 
often (i.e. a few times a day) you may wish to set this to 1 though it will slow down browsing speed. 
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The default of 3 is best for fastest browsing on most connections. You can experiment to see if 0 suits 
your needs, but don't use a value of 2.

browser.cache.disk_cache_ssl [Boolean] (False) - If set to true, this setting allows the caching of secure 
web pages in your browser cache. This speeds up loading of commonly-visited secure pages, but is an 
obvious security risk and for that reason it is recommended you keep this at false.

browser.cache.memory.capacity [Integer] *Create - This setting determines whether Firefox uses 
system RAM to cache itself, improving performance. A value of 0 turns off caching into RAM, which 
is not recommended as it can greatly slow down browsing. The default value of -1 tells Firefox to 
automatically determine the size of the cache based on your physical RAM. In Firefox 2.0, systems 
with 512MB of RAM will result in a 14MB cache, 1GB of RAM results in a 18MB cache, 2GB of 
RAM gives 24MB of cache, and 4GB of RAM results in 30MB of cache. These values are lower than 
the defaults in Firefox 1.5. The default of -1 should be fine for all people, but if you notice Firefox 
increasing its memory usage, you can manually restrict this value to a particular amount by entering a 
value in KB (e.g. a value of 18432 = 18MB).

browser.cache.memory.enable [Boolean] (true) - This setting works in conjunction with the 
browser.cache.memory.capacity setting above. If set to true, Firefox will use the value specified in the 
browser.cache.memory.capacity setting to determine how much RAM to use. If set to false, Firefox 
will not use any RAM to cache, resulting in a performance drop. I recommend setting this to true for all 
systems unless troubleshooting a potential memory-related problem in Firefox for example.

browser.chrome.favicons [Boolean] (true) - This setting determines the display behavior of the small 
site icons (usually called 'favicons') visible next to bookmarks and site URLs in the address bar. If set 
to true, these are downloaded and displayed; if set to false they are not. Turning off favicons may 
increase the responsiveness of the Bookmarks menu, but generally they are best left enabled..

browser.chrome.image_icons.max_size [Integer] - Determines the maximum size in pixels beyond 
which a thumbnail of an image won't be shown in a tab. If you don't want thumbnail images shown in 
tabs at all, set this to 0.

browser.chrome.toolbar_tips [Boolean] - If set to true, small 'tooltips' (popup boxes with descriptive 
text) will be shown when you hover over items in your Firefox toolbar, as well as on certain objects in 
some webpages. If you don't like tooltips, set this value to false, but again remember this may also 
disable useful descriptive tooltips on certain webpages.

browser.display.show_image_placeholders [Boolean] (false) - If set to true, image placeholders will be 
shown until the images are fully loaded. If set to false, these are not shown. I recommend setting this to 
false for a cleaner look as pages load, but it depends on your preference.

browser.download.manager.flashCount [Integer] (1) - This setting determines the number of times the 
Download Manager will flash in your Taskbar when a download is underway and the download 
manager is not visible. I recommend setting this to 1 to minimize annoyance, or you can disable it by 
setting it to 0.

browser.download.manager.openDelay [Integer] (2000) - The value here determines how many 
milliseconds of delay there will be before the download manager window opens at the start of a 
download. By default the download manager window opens immediately (0 milliseconds delay), 
however I recommend a value such as 2000 (2 seconds delay) so that for very small downloads you 
don't have to see the download manager window at all, yet the file will still be downloaded as usual.

browser.download.manager.showAlertInterval [Integer] - This setting determines for how many 
milliseconds the "Download Completed" alert is shown when you complete a download. Default is 2 



seconds (2000 milliseconds). If you want to disable the download completed alert altogether see the 
browser.download.manager.showAlertOnComplete setting below.

browser.download.manager.showAlertOnComplete [Boolean] - If set to false, the download manager 
"Download Completed" alert will not be shown at all.

browser.enable_automatic_image_resizing [Boolean] - If set to true (the default), images opened 
separately will be automatically resized to fit the screen, if set to false they will be shown at their full 
size.

browser.link.open_newwindow [Integer] - This setting determines where hyperlinks which would 
normally open in a new browser window end up opening. If set to 1, they open in the current Firefox 
window; if set to 2 they open in a new window; and if set to 3 (the default) all such links open in a new 
tab in the current Firefox window. Note that this setting is the same as that found under the in-browser 
Options>Tabs screen, however there is an additional choice here (setting it to 1).

browser.link.open_newwindow.restriction [Integer] - This setting determines how new windows 
launched by javascript (usually popups) are treated. If set to 0, all such windows are opened as tabs in 
the current window; if set to 1 they open as new windows; and if set to 2 javascript windows will be 
treated like any other opened link unless they have strict values set.

browser.sessionhistory.max_total_viewers [Integer] - This option determines how many pages to store 
in memory to speed up the back and forward buttons in Firefox. The default of -1 automatically 
determines the amount based on your system RAM. At 512MB of RAM, 5 pages are held in memory, 
while 1GB or more of RAM holds 8 pages. You can set this value to 0 to hold no pages in RAM (only 
recommended for troubleshooting memory problems), or increase the value if you often use the back 
and forward functions for more than 8 pages.

browser.tabs.closeButtons [Integer] - This setting controls how the red 'x' close buttons on tabs appear 
in Firefox. A value of 0 only displays the close button on the active tab, 1 (the default) shows it on all 
tabs, 2 results in no close buttons being shown at all, and 3 displays a single close button at the end of 
the tab bar.

browser.tabs.forceHide [Boolean] - If set to true, your tab bar will be hidden regardless of how many 
open tabs you have in Firefox. This is only recommended if you absolutely need every last inch of 
vertical viewing space.

browser.tabs.opentabfor.middleclick [Boolean] - If set to false, clicking the middle mouse button on a 
link will not open that link in a tab. This is counter to the default behavior of Firefox, and would only 
be recommended if you strongly object to middle click opening a tab for some reason.

browser.tabs.tabclipWidth [Integer] - Determines the minimum width of a non-active tab in pixels 
before a red 'x' close button appears. The default is 140, and raising this value increases the likelihood 
that a close button won't appaer on the tab. If you want to get rid of close buttons altogether you should 
consider using the browser.tabs.closeButtons preference above.

browser.tabs.tabminWidth [Integer] - As more tabs are opened, Firefox shrinks each tab's width. This 
setting controls the minimum width a tab can be, with the default being 100 pixels. Raising this value 
means less tabs can be displayed at any one time on the screen (the remainder are shown in the tabs 
drop down box at the far right of the tab bar).

browser.urlbar.clickSelectsAll [Boolean] - When set to true (which is the default), left-clicking once in 
the address bar automatically highlights all of its contents. If set to false, clicking in the address bar will 
only place a cursor where you click without highlighting any text first.



browser.urlbar.hideGoButton [Boolean] - If set to true, the green Go arrow/button next to the URL box 
will be removed.

browser.xul.error_pages.enabled [Boolean] (True) - If set to true which is the default, Firefox will 
display a full error page when it runs into an error (such as a 'page does not exist' error). If set to false, 
Firefox will only bring up a small dialog box with the error messager. I recommend this setting be left 
at the default of True to assist in troubleshooting web problems.

The next page continues the listing of About:Config preferences.

9. Advanced Tweaking (Pt.2)
config.trim_on_minimize [Boolean] (False) *Create - This setting only works in Windows, and 
determines whether Firefox - much like other Windows applications - reduces its memory usage when 
minimized to the Taskbar. If set to true (the default), it will use less memory when minimized, which is 
useful for systems with low RAM and multiple open applications. However if set to false it will speed 
up minimizing/maximizing Firefox, as it will not constantly attempt to reduce and reclaim RAM, and 
this can also increase stability - thus I recommend a setting of false for most people.

content.notify.interval [Integer] *Create - Note that for this setting to work, a new Boolean called 
content.notify.ontimer must be created and set to True as well. This value in microseconds (where 1000 
microseconds = 1 millisecond) determines how long Firefox buffers network data before displaying it. 
By default this is 120000 microseconds (120 milliseconds). Lowering this setting can improve display 
speed in Firefox, however it will also increase CPU usage to do so. Experiment with slight drops in 
value to 100000 or even 50000 and see if your results are beneficial. Don't drop this value to one which 
is extremely low however. If in doubt, do not change this value as you are more likely to slow Firefox 
down than speed it up. 

content.switch.threshold [Integer] *Create - This setting determines how long Firefox waits for user 
input (mouse or keyboard input) before switching to a less-responsive but less system-intensive low 
frequency mode while loading a page. The default is 750000 milliseconds, but raising this value might 
keep Firefox more responsive at the cost of greater system load and slightly longer page loading times. 
I don't recommend changing this value.

dom.disable_window_open_feature.* [Boolean] - There are 11 settings which begin with this tag (and 
end with one of the following: .close, .directories, .location, .menubar, .minimizable, .personalbar, 
.resizable, .scrollbars, .status, .titlebar, .toolbar). These settings control the appearance elements of 
popup windows which you can force to be displayed. For example, if you set the 
dom.disable_window_open_feature.close setting to True, it will force all popup windows which open 
up to have a close button in the top right hand corner of the popup window. This is useful since many 
popup windows (mainly ads) deliberately remove such elements to prevent easy resizing/closing of 
their content. For that reason I recommend you set at least the .close and .resizeable settings to true.

dom.popup_maximum [Integer] (5) - This setting determines the maximum number of simultaneous 
popup windows which can be open at any time to prevent the screen flooding with popups (as some 
malicious sites/malware can do). The default is 20, but I recommend a value such as 5 or even lower 
since most of the time users will only ever need 2 open legitimate popups at most on their screen at 
once. If you find legitimate popups being blocked, raise this value again, but never beyond 20.

extensions.checkCompatibility [Boolean] *Create - If this option is set to true, you will be able to 
install and use Extensions which are formally incompatible with Firefox 2.0. In some cases this may 
not cause any problems, however in a large number of cases there may be odd behavior or crashes. Use 
this setting with caution and backup your profile before installing and using an incompatible extension.



extensions.dss.enabled [Boolean] - If set to true, this option enables Dynamic Skin Switching (DSS). 
This means that whenever you install and/or switch to a new Theme in Firefox, its changes will be 
implemented and visible immediately, rather than having to close down all Firefox windows and 
relaunching Firefox. While this is handy, it can be quite buggy so if you're having problems with 
glitches in themes set this back to false.

extensions.spellcheck.inline.max-misspellings [Integer] - When the built-in spell check in Firefox is 
enabled, this option determines the maximum number of spelling mistakes the spell checker can 
encounter before it gives up. The default limit is 500, and on text entry boxes with large numbers of 
mistakes even this can cause a prominent slowdown. Lowering the limit can make Firefox much more 
responsive on such pages, but obviously results in less spelling mistakes being found.

extensions.update.interval [Integer] - If you've selected to check regularly for Extension updates, this 
setting determines how often to check for such updates. The default is once a day (86400 seconds) but 
you can increase or decrease the amount depending on whether the Extensions you currently have 
installed are being updated more or less regularly by the author(s).

intl.locale.matchOS [Boolean] - This setting is used by Firefox to determine where you are located in 
the world. If set to True, the setting tells Firefox to use the locale you've set in your operating system as 
your Firefox locale. If set to false, Firefox won't check or use your OS locale.

keyword.URL [String] - This setting determines the address to use to run searches when you type a 
word in the Firefox Address Bar. By default it points to Google, but entering a word in the address bar 
just goes to the first site Google finds (i.e. the default is the I'm Feeling Lucky search method). Instead 
you might want to try setting it to http://www.google.com/search?&q= which is the general Google 
search string. Now any time you enter a word in the address bar and press Enter it will take you to a 
Google page showing you the results of the search for that term. Alternatively you can use a completely 
different search engine of your choice.

keyword.enabled [Boolean] (True) - By default entering a word (and not a URL) in the Firefox Address 
Bar is considered a Keyword, and Firefox will either look for a bookmark with the same defined 
keyword and launch it, or commence a search in Google to find the most likely site from that word. If 
you don't like this functionality you can disable it by setting this value to False. Bookmark Keywords 
will still function however. Disabling this setting is generally not recommended as Keywords are a 
unique and highly useful feature of Firefox.

Layout.css.report.errors [Boolean] - By default Firefox reports all CSS errors in the Tools>Error 
Console. If you don't want CSS errors shown, set this to false.

Layout.spellcheckDefault [Integer] - This setting controls whether the built-in spell checker is disabled 
(0), enabled and checking multi-line text boxes (1 - the default), or enabled and checking all text boxes 
(2).

layout.word_select.eat_space_to_next_word [Boolean] - This setting determines the selection behavior 
when you double-click on a word on a web page. By default (True), Firefox selects the word and the 
white space on the right of that word. If set to False, Firefox will only select the word itself with no 
extra spaces. I personally prefer to have this set to False.

layout.word_select.stop_at_punctuation [Boolean] - This setting determines whether Firefox selects the 
punctuation around a word when it is double-click selected. If set to True, the punctuation is not 
selected with the word. If set to False, additional punctuation around the word is selected as well. For 
example double-clicking on the word (default) in Firefox will either just select default or (default) 
based on this setting.

http://www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=navclient&gfns=1&q=


network.dnsCacheEntries [Integer] *Create - This setting determines how many entries should be held 
in the Firefox DNS (Domain Name System) cache. Whenever you enter a web address in Firefox, it 
needs to convert that text address into an IP number. It does this by looking up the name and IP number 
through a DNS server. By holding DNS entries in a local cache, the next time you want to go to the 
same site Firefox can load it up much faster. By default Firefox holds 20 entries in the cache. I 
recommend changing this number to match at least the number of sites you regularly browse. More 
importantly, check the setting below to ensure DNS entries are kept up to date.

network.dnsCacheExpiration [Integer] *Create - This setting determines how long the cached DNS 
entries (as set by the network.dnsCacheEntries setting) are held before they are discarded. The default 
is 60 (seconds), however before changing this setting consider the pros and cons - the longer cached 
entries are held, the quicker your browsing may be, but the longer it may take for Firefox to be aware 
that a site which was temporarily considered unavailable (unresolved) is now accessible (resolved).

network.http.max-connections [Integer] (48) - This setting determines how many simultaneous HTTP 
connections can be made by Firefox. The default is already 24, however for most people on moderate 
to fast Internet connections you can try raising this to a value like 48 or even 96 to allow for more open 
connections, thereby speeding up browsing multiple pages. The maximum is 65535, but remember that 
by raising this setting you are only raising the maximum possible number of connections. You aren't 
forcing Firefox to increase the actual number of connections it makes every time; if your system 
actually attempted to force 300 connections to open at once for example it would likely slow down to a 
crawl.

network.http.max-connections-per-server [Integer] (16) - This setting determines how many 
simultaneous connections can be made to a single server. The default is 8, however you can increase 
the value for broadband connections to something like 16 or 32 to attempt to increase browsing speed. 
The maximum is 255, however note that raising this setting to a high value (in conjunction with a high 
value for the network.http.max-persistent-connections-per-.* settings below) may be construed as a 
DDoS (Distributed Denial of Service) attack by some servers and your connection may be refused or 
even permanently banned. I strongly suggest that you keep this value sane. Simply increasing the 
number of connections to a server doesn't necessarily make things any faster, and indeed if every 
Firefox user does this then overall most sites will become slower.

network.http.max-persistent-connections-per-proxy [Integer] (8) - If you are connected to a proxy, this 
setting determines how many connections to keep alive at any time. The default is 4, however you can 
attempt a higher value such as 8 to improve browser speed. As mentioned in the settings above, raising 
this to a very high value will put additional stress on the proxy server and may ultimately result in 
slower browsing for everyone on the proxy and/or a refused connection.

network.http.max-persistent-connections-per-server [Integer] (8) - If you are not connected to a proxy, 
this setting determines how many connections to a single server to keep alive at any time. The default 
is 2, however you can attempt a higher value such as 8 to improve browsing efficiency. The maximum 
possible is 255, and as mentioned in the settings above, raising this to a very high value will put stress 
on the particular websites you are connected to and will either result in a refused connection, or slower 
response times from the web page for every person trying to connect to it. Do not raise this value to one 
which is very high as it is inconsiderate and counter-productive if everyone does so.

network.http.pipelining [Boolean] (True) - If set to True, this setting uses the HTTP Pipelining feature 
supported by some servers and proxies. This can improve browsing speeds, however because the 
feature is not supported by all servers you may experience problems on some sites with it enabled. I 
recommend setting this to True and only disabling it if you experience problems such as refused 
connections or unusual behavior.

http://www.mozilla.org/projects/netlib/http/pipelining-faq.html


network.http.pipelining.maxrequests [Integer] (8) - This setting determines the maximum number of 
requests to send when using the HTTP Pipelining feature (see above). The default is 4, and the 
maximum possible is 8 (higher values are ignored), while a value of 1 disables pipelining. I recommend 
setting this to 8 and only reducing it back to 4 if you experience any problems with the Pipelining 
feature.

network.http.proxy.pipelining [Boolean] (True) - If set to True, this setting enables the HTTP 
Pipelining feature (see network.http.pipelining above) for proxy servers. This can improve browsing 
speeds, however because the feature is not supported by all proxies you may experience problems. I 
recommend setting this to True and only disabling it if you experience such problems as refused 
connections, longer page loading times, or unusual behavior. Note that network.http.proxy.keep-alive 
must be set to true for this to work.

network.http.redirection-limit [Integer] - This setting determines how many consecutive redirects 
Firefox will accept. For example if you click on an outdated link to a particular site, once arriving there 
you may be automatically redirected to the new address for that site. That would be one redirect. If you 
want to block sites which spam multiple automatic redirects (usually malicious sites), you can lower 
this value to 10 for example, or even less. I don't recommend disabling automatic redirection (i.e 
setting this to 0) as many sites use legitimate redirects, such as most Internet forums after you have 
posted a message. I also don't recommend raising this limit about 20.

network.prefetch-next [Boolean] (False) - This setting determines whether to use a Firefox feature 
called Link Prefetching. See the Neat Stuff & Conclusion section for a practical example, and why you 
may want to set this preference to False.

nglayout.initialpaint.delay [Integer] *Create- This setting determines how many milliseconds Firefox 
should wait before it starts to display the page contents. This brief delay allows Firefox to load and 
arrange the various page components as correctly as possible. The default is 250 milliseconds which 
isn't very long, but you can try setting this to 0 to see if it improves the responsive feel of Firefox at the 
expense of slightly longer load times. Some users report faster overall page load times with the default 
value or even higher, so experiment to see which value suits your browsing habits, and if in doubt do 
not create or alter this setting.

plugin.default_plugin_disabled [Boolean] - When viewing a web page which requires a Plugin (such as 
Flash) Firefox will prompt the user to install this plugin. If you don't ever want to see any such 
prompts, set this setting to False.

print.use_global_printsettings [Boolean] - If set to True, Firefox will use the same printer settings you 
chose globally for every open Firefox window. If set to False, each open Firefox window can have a 
separate print setting applied to it.

privacy.popups.disable_from_plugins [Integer] - Some sites use scripts to circumvent the popup 
blocker and launch a popup window when you click on the page. If this preference is set to 0 it doesn't 
block any such popup windows; if set to 1 it limits the maximum of popups (based on the 
dom.popup_maximum setting - see above); and if set to 2 it blocks all popups from plugins (except for 
sites in your list of Allowed Sites under the Options>Contents popup Exceptions) - this is the default 
setting; if set to 3 blocks all popups regardless.

privacy.popups.showBrowserMessage [Boolean] (False) - By default the first time Firefox blocks a 
popup (if the popup blocker is enabled in Tools>Options>Web Features) then it will ask you whether 
you want to display a message each time a popup is blocked. The answer you provide at that time sets 
the default for this setting, but you can change it at any time by editing this preference. For the sake of 
reducing annoyance I recommend you set this to False.

http://www.mozilla.org/projects/netlib/Link_Prefetching_FAQ.html


That concludes the About:Config preferences list. The next page continues the advanced tweaking, 
covering UserChrome.css and UserContent.css tweaks.

10. Advanced Tweaking (Pt.3)
Web pages often use CSS (Cascading Style Sheets) to define basic elements such as what color 
hyperlinks are, the size and type of fonts used to display text in various parts of the page, and so forth. 
The files UserChrome.css and UserContent.css are described in the Customizing Firefox section, but 
essentially they work on the same theory - they define the basic elements of the user interface and web 
layout presented by Firefox. UserChrome.css can be used to customize various elements of the Firefox 
user interface, while UserContent.css can be used to customize the appearance of web pages displayed 
within Firefox.

By default neither of these files exist, and must be created in the \Documents and 
Settings\[username]\Application Data\Mozilla\Firefox\Profiles\[profilename]\chrome subdirectory of 
your relevant Profile folder. For instructions on creating these files see the Customizing Firefox section 
of this guide. Alternatively you can just rename the UserChrome-example.css and/or UserContent-
example.css files under that directory by removing the -example portion of the name.

These files can be edited using a text editor such as Windows Notepad. Note that you can find a more 
detailed list of these types of tweaks at sites like Mozilla Firefox Tips & Tweaks. Alternatively, you 
can find yourself a good CSS Tutorial and learn how to generate and manipulate your very own CSS 
code to create the perfect customizations to suit your needs. I don't recommend editing CSS files unless 
you are at least familiar with how CSS works.

 

Below are a few useful tweaks which you can copy and paste into the relevant CSS file to enable 
different functionality:

UserChrome.css
Use a Custom Background Image for Toolbars
/* Use a background image for the toolbars:
(Substitute your image file for background.gif) */
menubar, toolbox, toolbar, .tabbrowser-tabs {
background-image: url("background.gif") !important;
background-color: none !important; }

Note the image must be in .GIF format, and be placed in the same directory as the UserChrome.css file 
for this tip to work.

http://www.westciv.com/style_master/academy/css_tutorial/index.html
http://www.mozilla.org/support/firefox/tips
http://www.tweakguides.com/images/Firefox_8.jpg


Change Color of Tabs
/* Change color of active tab */
tab{ -moz-appearance: none !important; } tab[selected="true"] {
background-color: rgb(222,218,210) !important;
color: black !important; }

/* Change color of normal tabs */
tab:not([selected="true"]) {
background-color: rgb(200,196,188) !important;
color: gray !important; }

Note if you want to further change the colors used, simply edit the values shown in the rgb and color: 
lines. To determine new RGB values, try this RGB Color Chart. For the color values, use common 
words like white, black, blue etc.

Remove Close Button from Tab Bar
/* Remove the close button on the tab bar */
.tabs-closebutton-box { display: none !important; }

Remove Firefox Menu Items
/* Remove the Go and Help menus
(These are just examples. Try changing "Go" to "Edit" or "Bookmarks") */
menu[label="Go"], menu[label="Help"] {
display: none !important; }

Note that you can remove any menu items you want by inserting their names (File, Edit, View, Go, 
Bookmarks, Tools or Help) in place of "Go" or "Help" above. You can also remove more than two 
menus items by adding more instances of menu[label=""]after the existing menu commands, as long as 
each is separated by a comma followed by a space.

Display Sidebar on the Right
/* Place the sidebar on the right edge of the window */
window > hbox {
direction:rtl; } window > hbox > * {
direction:ltr; }

If you use the Sidebar (under the View>Sidebar menu in Firefox), you can switch it from displaying on 
the left to the right side of the screen.

Increase Search Bar Width
/* Make the Search box flex wider
(in this case 400 pixels wide) */
#search-container, #searchbar {
-moz-box-flex: 400 !important; }

If you use the Web Search box in Firefox, you can increase its width to any value you wish (in pixels) 
by editing the value shown after -moz-box-flex setting above.

UserContent.css
Change Cursor for Links Which Open in New Windows
/* Change cursor for links that open in new window */
:link[target="_blank"], :visited[target="_blank"],
:link[target="_new"], :visited[target="_new"] {
cursor: crosshair; }

This changes your default cursor to a crosshair whenever you hover over a link which opens in a new 
window by default.

Block Flash Animations & Advertisements
/* Block Flash, using a placeholder you can click to unblock a desired Flash animation. */
/* Doesn't work for embed tags, which are less common than object tags - bug 190970 */
object[classid$=":D27CDB6E-AE6D-11cf-96B8-444553540000"],
object[codebase*="swflash.cab"] {
-moz-binding: url("http://www.cs.hmc.edu/~jruderma/flash.xml#obj"); }

This replaces all Flash advertising and Flash-based elements with a 'Click to Play' prompt. You can 

http://www.hypersolutions.org/pages/rgbdec.html


then play the flash animation if you wish, or you can continue to ignore it on a web page.

Remove All Embedded Content
/* Nuke all embedded objects, thanks to bertilow on Slashdot */
object, embed { display: none; }

This is a very simple but very powerful tweak which removes completely all embedded content, 
usually the more annoying flash, shockwave animations and so forth. The combination of this tweak 
and the one above can remove much of the flashing elements of web pages.

As you can see, there is no end to the possibilities of tweaking Firefox's interface and web display 
capabilities. I strongly recommend that if you're interested in having a browser completely suited to 
your needs you try to learn some CSS, as it's not very difficult to pick up the basics.

The next page covers a range of Extensions and Themes (Add-ons) which can perform many of the 
tweaks outlined above, and plenty more. These are ready-made plugins for Firefox which add 
additional functionality and have even greater tweaking potential, particularly for those who don't wish 
to tweak Firefox manually.

11. Extensions & Themes
One of the major attractions of Firefox is the amazingly numerous ways you can customize its function 
and appearance. Up to now the guide has presented you with a range of simple to advanced methods 
for customizing Firefox to suit your needs. There are a range of Add-ons - mainly Extensions and 
Themes - which you can download to allow you to customize and enhance Firefox to a great extent. 
This section details a few of them and is a good introduction to how the Add-on process works in 
Firefox.

Add-Ons Manager
As of Firefox 2.0, there is now a single area where you can manage add-on software for Firefox - it can 
be found under the Tools>Add-ons menu item. Under the Add-ons Manager you will see there are two 
sections: Extensions and Themes. An Extension is a piece of software which enhances or alters 
Firefox's behavior; a Theme is software which alters Firefox's appearance.

Firefox starts with no Extensions or additional Themes installed. Most of the functionality you need is 
already inherent in Firefox. However to start exploring your possibilites with add-ons, open the Add-on 
Manager, select either the Extensions or Themes button, then at the bottom of the box click the Get 
Extensions or Get Themes link as relevant. You will go to a secure site run by Mozilla which stores a 
wide range of extensions and themes for you to install.

Extensions

 

https://addons.mozilla.org/firefox/themes/
https://addons.mozilla.org/firefox/extensions/
https://addons.mozilla.org/firefox/extensions/
http://www.tweakguides.com/images/Firefox_9.jpg


Installing an extension is very simple. Browse to the extension you want, click the 'Install Now' button, 
then once finished, you should close the Add-ons box and all instances of Firefox, then relaunch 
Firefox. You can experience the additional functionality straight away. Note that usually you should 
only download and use extensions available from the site shown above - the official Firefox Extensions 
Site. Aside from listing approved extensions, it is a secure site (note the https: in the address), so you 
will not be tricked into installing malicious software on your system. Of course this doesn't mean all 
extensions work perfectly - some of them can be quite buggy, and many of them are not compatible 
with Firefox 2.0 or newer (though you can force them to be used by changing the 
extensions.checkCompatibility preference - see the Advanced Tweaking section), so make sure you 
read the release notes on the download page. Also make sure to regularly check for updates for your 
installed extensions by going to the Add-ons box, clicking the Extensions icon, highlight the extension 
and click the 'Find Updates' button. Finally, for troubleshooting purposes I generally don't recommend 
installing too many extensions, as this might cause strange behavior in Firefox or performance issues, 
so only install the extensions you genuinely need.

Some of the more useful Firefox extensions you can try are listed below:

Preferential

This is a handy utility which allows easier access to the about:config preferences covered in the 
Advanced Tweaking section of this guide by providing a better user interface.

Adblock

This extension allows you to select which elements of each web page to block - thus you can 
effectively remove the more annoying ads on any particular web page. There has been a lot of 
controversy surrounding this extension - you have to realise that if you block all ads (even unobtrusive 
Google ads for example) you may eventually contribute to the closure of certain sites. Love 'em or hate 
'em, ads are what make the Internet free, so be cautious with what you block. I do wholeheartedly 
support the blocking of all in-your-face and annoying ads such as popups, flash ads etc.

NoScript

This extension gives you far greater control over the way Javascript, Java and other executable content 
is run on various websites. Scripts are notorious for being abused by malicious or annoying websites, 
and once you've added your trusted websites to the list, Noscript will protect you from most malicious 
or annoying content, also allowing you to toggle script on or off as needed.

Google Toolbar

The original Google Toolbar available directly from Google now works with Firefox. You can either 
install it, or instead, if you prefer a more streamlined version, try Googlebar Lite.

IE Tab

A few web pages still don't display correctly on Firefox, or only allow IE to view them (such as 
Windows Update). This extension allows you to quickly view a page in IE in a new tab in Firefox.

ForecastFox

This extension provides you with a range of customizable toolbar items which show you weather 
forecasts from around the world, updated from Weather.com.

Mouse Gestures

This extension allows you to use mouse gestures - movements of your mouse in particular ways - to 
activate common browser commands in Firefox, like back, forward and close tab.

https://addons.mozilla.org/firefox/39/
https://addons.mozilla.org/firefox/398/
https://addons.mozilla.org/firefox/1419/
http://www.google.com/tools/firefox/toolbar/index.html
https://addons.mozilla.org/firefox/722/
https://addons.mozilla.org/firefox/10/
https://addons.mozilla.org/firefox/713/
https://addons.mozilla.org/firefox/492/


Themes
Themes are basically skins for Firefox. Installation of themes is similar to extensions, and to apply a 
theme go back to your Add-ons box, select the Themes icon and then double-click on the theme you 
wish to use. Typically you will have to close all instances of the Firefox browser and relaunch for the 
theme to come into effect properly. As with extensions, many themes are not designed for use with 
Firefox 2.0 or newer, so read the release details carefully - incompatible themes can be installed but 
will not be activated after installation. And similar to extensions, to check to see if your existing themes 
have updates, highlight the theme and click the 'Find Updates' button.

 

Some of the Themes I personally like which are compatible with Firefox 2.0 include:

Mostly Crystal

Noia

Phoenity

Azerty

GrayModern

CloudGnome

Scribblies

A lot of themes still need to be ported over to Firefox 2.0 so you should be patient.

There are literally hundreds of other extensions and themes you can download and try for yourself. 
This is one of Firefox's strengths - its open source code and large community mean that virtually any 
kind of feature, function or appearance you desire in a browser is likely to be already available 
somewhere through an extension or theme. Of course keep in mind that if you're experiencing any odd 
behavior in Firefox, try uninstalling any recent extensions or themes in case they are the cause of the 
problem.

The next section wraps up the guide with a few important tips to further improve Firefox, and some 
concluding thoughts.

https://addons.mozilla.org/firefox/1905/
https://addons.mozilla.org/firefox/695/
https://addons.mozilla.org/firefox/870/
https://addons.mozilla.org/firefox/3594/
https://addons.mozilla.org/firefox/1439/
https://addons.mozilla.org/firefox/1406/
https://addons.mozilla.org/firefox/72/
http://www.tweakguides.com/images/Firefox_10.jpg


12. Neat Stuff & Conclusion
This section brings the guide to a conclusion, but not before providing a few more tips which may be of 
some help.

Speed Up Firefox Load Times
Firefox is quite slow to load up the first time in each computing session compared with Internet 
Explorer. This is because Internet Explorer's core files are already loaded up with Windows. For the 
most part not much can be done about Firefox's load up time, and the /Prefetch switch which was 
included in this section previously has been proven to have no impact. It's not a big deal to me, but if 
you find it incredibly annoying, you might want to try Firefox Pre-Loader, a program which attempts to 
preload portions of Firefox into memory so that it is quicker to launch. Microsoft's own normal 
prefetch feature (on by default in Windows XP) also tries to do this for all applications, so experiment 
to see if FFPreloader improves load times any further on your machine.

Disable Google Prefetching
A feature introduced by Google and only used by Mozilla and Firefox browsers at present is called 
Google Prefetch. This is not the same as the prefetching used by Windows (as covered above), so don't 
get confused - this feature tries to loadup what Google believes is the most likely page you want to 
view as a result of certain Google searches you initiate. It does this in the background without 
informing you, and I personally don't think it's necessary. You may notice your browser cache may 
have web elements (e.g. cookies) from pages you haven't visited yet - this is because of Google 
Prefetch.

Some websites also use this prefetch feature to speed up loading of the 'Next'/'Previous' pages of an 
article for example (no, TweakGuides doesn't do this). As such, it is not a terrible feature, although I 
personally still prefer to disable it and maintain full control over what my browser loads up in the 
background. If you wish to disable this feature in Firefox, go to About:Config, find the 
network.prefetch-next setting and set it to False. This will improve security, but again the choice is up 
to you. See the Customizing Firefox and Advanced Tweaking sections for details on how to use 
About:Config.

View Source Code for Selected Portions of Web Pages
If you're interested in website design you may already regularly go to the View menu in Firefox and 
select 'Page Source' to see the source code for certain pages. This is a handy feature, but is already 
common to most browsers. However Firefox takes this nifty feature one step further: select only a 
portion of a web page by holding down the left mouse button at the start of your selection, then 
dragging the cursor to the end of your selection and releasing the left mouse button. Now right-click on 
this highlighted selection, and in the context menu select 'View Selection Source' - the source window 
will open and only show the coding related to the portion of the web page you've highlighted. This is 
very useful if you don't want to wade through large chunks of code just to see how a neat effect works 
on a page, or if you can't figure out which portion of code relates to which section.

I Need More Help With Firefox!
Unfortunately I can't provide tech support for this or any of my other guides due to time reasons, so 
please don't email me asking me for help. In general all the information you need is right here in this 
guide, as long as you are patient and read it carefully. However if you need more help you should 
check out the following Firefox Help resources which are officially provided by Mozilla.org.

http://www.mozilla.org/support/firefox/
http://www.tweakguides.com/FAQ.html#Q11
http://www.google.com/help/features.html#prefetch
http://sourceforge.net/projects/ffpreloader/


Conclusion
That brings this Firefox Tweak Guide to a close. I hope you've found the tips and tweaks herein useful 
and informative. Just like all my other tweak guides, I have made sure this guide remains updated 
based on user feedback and as new official versions of Firefox are released. It's already been 
significantly revised for Firefox 1.5, and now Firefox 2.0. To help me keep the guide as accurate as 
possible, please Email Me with your Firefox corrections/suggestions/tips.

Since my release of this guide in early 2005 I've had a fair few people email me telling me about 
Firefox tweaking utilities. My opinion of these as always is that no software, however well designed, 
can tweak an application or game for you. Many of the tweaks and tips for Firefox require you to make 
a choice about what suits you: there is no "right" setting for every machine. I strongly suggest you 
overcome any feelings of laziness and actually take the time to read this guide in detail to find out how 
Firefox works, otherwise you really won't be able to take full advantage of Firefox.

Useful Links
The following are some very useful sites which I used to help compile this guide. I strongly 
recommend you visit these sites if you're interested in understanding more about Firefox.

Official Firefox Site
http://www.mozilla.org/products/firefox/

Firefox Help: Tips Tricks
http://www.mozilla.org/support/firefox/tips

Official Firefox FAQ
http://www.mozilla.org/support/firefox/faq

Firefox Help, Tips & Tricks
http://www.techlifeweb.com/firefox/firefox_tips.html

Ten Mysteries of About:Config
http://www.linuxjournal.com/article/8004

Mozillazine About:Config
http://kb.mozillazine.org/Firefox_:_FAQs_:_About:config_Entries

Mozdev Documented Preferences
http://preferential.mozdev.org/preferences.html

Mozillazine Forums
http://forums.mozillazine.org/index.php?sid=257

Until next time, take care!

http://forums.mozillazine.org/index.php?sid=257
http://forums.mozillazine.org/index.php?sid=257
http://preferential.mozdev.org/preferences.html
http://preferential.mozdev.org/preferences.html
http://kb.mozillazine.org/Firefox_:_FAQs_:_About:config_Entries
http://kb.mozillazine.org/Firefox_:_FAQs_:_About:config_Entries
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